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Installation

You can install Wirecast on any Mac or Windows computer that meets the minimum 
system requirements.

Topics
■ General System Requirements

■ Installing Wirecast

■ Purchasing and Activating Wirecast

■ Activating Wirecast on One Computer from Another Computer

■ Upgrades Included

■ Checking for Wirecast Updates

■ Deactivating Wirecast

■ Uninstalling Wirecast

■ Installing a Hardware Controller

■ Preventing Dropped Frames from Vertical Sync

■ Preventing Dropped Frames from Short Latency

■ Choosing a Video Adapter

General System Requirements

Operating System
• Minimum: Windows 10 version 1803 or higher

• Recommended: Windows 10 version 1903

Processor
• Minimum: i5 dual-core @ 2.3GHz, 6th generation or higher

NOTE: May be insufficient for 1080p+ or 60 fps workflows
How to check the generation of your Intel processor

https://support.telestream.net/s/article/Wirecast-How-to-check-the-generation-of-your-Intel-processor/


Installation4

Wirecast User Guide

• Recommended: i7 quad-core @ 2.8GHz+

Memory
• Minimum: 4GB RAM

• Recommended: 16GB+ RAM

Hard Drive
• Minimum: 2GB, 7200 RPM for record to disk

NOTE: Additional hard disk space required for record to disk

• Recommended: 500GB+, Solid State OS Drive

Graphics Card
• Minimum: Intel HD, DirectX 11 capable

NOTE: Insufficient for advanced Multi-Viewer workflows

• Recommended: Nvidia GeForce or AMD Radeon, 1GB+ video memory

Internet Connectivity
• Minimum: Open HTTP/HTTPS port 80, RTMP port 1935,

port 7272 for Remote Desktop Presenter

• Recommended: If behind a firewall, check with your CDN for any sites to whitelist.

Note: We recommend running Wirecast on the Windows Aero theme, which includes 
a hardware accelerated window manager. Running Wirecast on the Windows Classic 
theme can cause performance issues.

Rendezvous Requirements
Wirecast Rendezvous uses WebRTC technology that can be very resource intensive. For 
the best Rendezvous experience, we recommend the following hardware:

                                Studio (2 guests + 1 host)                    Pro (7 guests + 1 host)

Bandwidth4       Add 4 Mbps                                                Add 5+ Mbps5 

Processor4           i5 quad-core6                                             i7 quad-core6 

4 BBased on a single simultaneous stream of 720p30 x264 @ 4.0Mbps.
5  Bandwidth per guest will scale downwards as more are added to maintain reliability.
6  Minimum recommended processor with example stream4. More demanding workflows 
may require a more capable CPU.
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Internet Connectivity
• Requires Internet connectivity with HTTP/HTTPS port 80, and RTMP port 1935 open 

for streaming, Remote Desktop Presenter requires opening port 7272.

• An Internet connection is recommended for Wirecast license activation.

• It is recommended that an upload rate of at least double the desired rate be avail-
able.

– For lowest quality (240p) streaming an upload rate of at least 650Kbps is 
required.

– 720p streaming requires an upload rate of at least 2500 Kbps.

– 1080p streaming requires an upload rate of at least 4500 Kbps.

ISO Recording Requirements

Note: You cannot record the following using ISO: Rendezvous callers, Web Stream 
plugin, IP Cameras, Web Page plugin and Wirecast Go.

• Solid State Drive or fast RAID array recommended for ISO Recording and Replay 
functionality.

• Actual data rates will vary depending on quality level selected for ProRes (Mac) or 
MJPEG recording (Windows), as well as the resolution and frame rate selected.

• For Mac ProRes recording please refer to Apple’s ProRes data rate specifications.

• Total expected data rate should be compared to available disk write speed to 
ensure adequate disk throughput.

Note: Failure to ensure the available disk write speed is greater than the highest 
expected total data rate may result in frames being dropped from recordings (ISO, 
Replay, and Record-to-Disk).

Recommended Hardware
• Intel Core i3 CPU @ 1.7 Ghz or higher recommended for 540p streaming with x264 

@ 30 fps.

• Intel Core i5 CPU @ 2.5 Ghz or higher recommended for 720p streaming with x264 
@ 30 fps.

• Intel Core i7 CPU @ 3.0Ghz or higher recommended for 1080p streaming with x264 
@ 30fps.

Note: 60 FPS streaming will result in increased CPU usage and a high bit rate (4Mbps 
or higher) for good quality.

• Minimum 4GB RAM, 2GB free hard disk space. Additional hard disk space required 
for recording to disk.
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Hardware Accelerated Encoding Requirements
• Intel Quick Sync Video encoding requires an Intel CPU with an Intel® QuickSync 

Video core.

• NVIDIA NVENC encoding requires an NVidia GPU with Kepler architecture or newer.

Installing Wirecast
To install Wirecast, follow these steps:

1. Download the installer from the Telestream website:

https://dynamic.telestream.net/downloads/download-wirecast.asp?prodid=wirecast.

2. Run the installer (.exe) program and follow the instructions provided.

Note: The Wirecast installer asks whether you want to install the Virtual Microphone 
feature. If you do (recommended), check the box for this feature and continue the 
installation. You must have administrative rights to install Virtual Microphone.

3. If you have an older version of Wirecast already installed on your computer, the 
installer upgrades to the newer version.

Purchasing and Activating Wirecast
To purchase and activate Wirecast, do the following:

1. Launch Wirecast.

2. Select File > Preferences > Licenses, and click Purchase. Purchase Wirecast. Enter your 
license key into the License Key field. If you previously purchased a copy of Wirecast 
and want to use that serial number, enter that serial number.

3. Click Activate.
Wirecast validates the serial number and unlocks Wirecast.

4. Close the Preferences window.

Telestream activates your Wirecast program.

Note: You can also purchase a serial number at www.telestream.net.

See License Key.

Activating Wirecast on One Computer from 
Another Computer

If the computer where Wirecast is installed is not on the Internet, you can use another 
computer to activate your license and unlock Wirecast. To activate your license from 

http://www.telestream.net/wirecast/overview.htm
http://www.telestream.net/wire-cast/overview.htm
https://dynamic.telestream.net/downloads/download-wirecast.asp?prodid=wirecast
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another computer, follow the steps in the Manual Activation Guide at: 
http://www.telestream.net/telestream-support/wire-cast/training.htm.

Upgrades Included
With each purchase of Wirecast – whether it is an upgrade purchase or full license – you 
receive an Access Support subscription for one year from the date of purchase. You can 
renew this subscription annually.

You can choose to upgrade from an Access Support subscription to a Premium Support 
subscription at any time, for an additional fee. You can also renew Premium Support 
subscriptions annually.

Your support subscription is tied to your Wirecast license. As long as your license is 
entered into the software and your Premium or Access support subscription is active, 
you will be allowed to upgrade to the latest unlocked version of Wirecast for free. To do 
this, download and install the latest version of Wirecast. You will automatically have 
access to all the new features (depending on your license level).

If your support subscription is expired, or you have not entered your license into the 
software, you will not be able to upgrade to an unlocked version and the software will 
revert to demonstration mode. However, you may continue to use the last valid version 
of the software released during your support subscription coverage.

If your support subscription is about to expire (12 months from the date of purchase), 
Wirecast will prompt you to renew it. If you do not renew it before it expires, you may 
re-subscribe at any time for an additional fee.

See also Software Update Preferences.

Checking for Wirecast Updates
To check for Wirecast software updates, do the following:

1. Select File > Preferences > Software Update,

2. Click Check Now.
Wirecast checks for updates, but does not transmit personal information to 
Telestream during this action.

See also Software Update Preferences.

Deactivating Wirecast
Deactivating a serial number on one computer allows you to re-activate it on another 
computer. Without an activated license, Wirecast adds water-marking to the video and 
audio whenever licensed features are used.
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Note: You can always reactivate a serial number by re-entering it into the License Key 
field and clicking Activate.

To deactivate Wirecast, do the following:

1. Select FileWirecast > Preferences > Licenses.

2. Click Deactivate.
Wirecast deactivates the serial number and removes it from the License Key field.

Note: You can access the License Reset Tool at:
https://www.telestream.net/telestream-support/deactivate-software.htm

See License Key.

Running Wirecast Without an Activated License
With no active serial number, Wirecast enters demonstration mode. In demonstration 
mode, Wirecast watermarks all outputs (both to disk and network). The video water-
mark is a periodic overlay of the Wirecast logo. The audio watermark is a periodic voice-
over. If you have a Wirecast serial number and are using a Wirecast Pro feature without a 
Pro license, Wirecast also watermarks that output.

Uninstalling Wirecast
To uninstall Wirecast, follow these steps:

1. Run the Wirecast installer (.exe) program.
The installer asks if you want to repair or remove the existing version.

2. Select Remove to uninstall the existing version of Wirecast.

3. Choose the Wirecast program icon in Finder > Applications, or on your desktop.

4.

Installing a Hardware Controller
You can control many Wirecast functionalities with some external hardware controllers, 
or Human Interface Devices. Wirecast provides control of three MIDI controllers: APC 
MINI, APC40mk2, Launchpad MK2, and one X-keys controller: XKeys 128.

To install a hardware controller for Wirecast, do the following:

1. Select FileWirecast > Preferences > Controllers.

2. Select a controller from the drop-down menu.

3. To close the Preferences dialog box, click the “x.”

See Controllers Preferences.

https://www.telestream.net/telestream-support/deactivate-software.htm
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Preventing Dropped Frames from Vertical Sync
You can prevent Wirecast from dropping frames, and optimize Wirecast performance 
by disabling vertical sync.

Wirecast usually synchronizes its video display with the refresh rate of your display. 
However, this degrades performance when the Wirecast program window is not visible 
(due to the screen being locked, Wirecast minimized, or the Wirecast covered by 
another application).

Note: Disabling vertical sync can interfere with the smooth display of video in the 
Wirecast user interface. This does not, however, decrease the broadcast video 
quality.

In order to avoid dropping frames, do the following:

1. Select File > Preferences > Advanced.

2. Check Disable Vertical Sync.

3. To close the Preferences dialog box, click the “x.”

Preventing Dropped Frames from Short Latency
You can prevent Wirecast from dropping frames, and optimize Wirecast performance 
by lengthening latency.

Wirecast adds latency to all incoming sources. Latency is the brief period between 
receiving live video and displaying it or processing it. Adding latency gives Wirecast 
time to store the incoming data properly. This preference lets you specify the length of 
the latency. The lower this value, the less time Wirecast takes between receiving data 
and using it. If the connection is not fast enough, or the latency is too brief, this may 
result in dropped video frames (less noticeable) and audio blips (very noticeable). The 
higher this value, the more time Wirecast has to store data before displaying or 
processing it.

In order to avoid dropping frames from short latency, do the following:

1. Select File > Preferences > Advanced.

2. Enter a value into the Application Source Latency field.

3. To close the Preferences dialog box, click the “x.”

See Application Source Latency.

Choosing a Video Adapter
If your computer has multiple video adapters, such as NVIDIA, AMD, or Intel graphics 
cards, you can determine which video adapter Wirecast uses. To select a video adapter, 
do the following:

1. Select File> Preferences > Advanced.
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2. From the Video Adapter drop-down menu, select the video adapter desired. Choose 
a video adapter.

3. To close the Preferences dialog box, click the “x.”
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Tutorials

The best way to get started using Wirecast is to quickly work through all its main 
features. This tour presents a series of three tutorials, each designed to help you 
understand how to create and broadcast presentations using Wirecast.

As you work through these tutorials, you will become familiar with important Wirecast 
concepts. The more you know about Wirecast, the better it will serve your broadcasting 
objectives.

Because each tutorial builds on the skills and knowledge you learn in the previous 
tutorials, it is recommended that you take the tutorials in order. Working through all the 
tutorials takes about thirty minutes.

Note: If you run the tutorial before activating a Wirecast license, or with Wirecast in 
demonstration mode, Wirecast periodically superimposes a logo watermark over the 
video, and a voice-over watermark over the audio.

Note: For licensing information, select File > Preferences > License. Click Purchase. Or, 
contact Telestream at: desktopsales@telestream.net.

Topics
■ Tutorial 1: Basic Concepts

■ Tutorial 2: Editing Shots

■ Tutorial 3: Broadcasting
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Tutorial 1: Basic Concepts
The goal of this tutorial is to provide you with a quick experience creating and 
streaming a presentation using Wirecast.

Tutorial Prep
To prepare for this tutorial, do the following:

1. Select Help > Create Document for Tutorial.

2. Select Switch > Smooth.

3. Select Switch > AutoLive.

4. De-select Switch > Live/Preview Swap.

5. Select Layout > Show Live Only.
Wirecast displays the Live Broadcast Area, and the Go button with the red AutoLive 
LED turned on. You will change all of these options in the tutorial.

The Wirecast Default Layout
To familiarize yourself with the main windows, controls, and menus of Wirecast, see The 
Default Layout.

What Is a Shot?
Wirecast uses the concept of a “shot” to construct presentations. A shot contains one or 
more media sources or files, along with settings for the sources and files. A shot 
contains at least one media file, such as a photo or a video clip. However, a shot can 
contain a number of sources and files, such as a live camera, a title, and background 
music. A shot can even include a whole playlist of clips.

You can assemble most of the files and sources for your broadcast, in shots, before you 
start broadcasting. Also, you can edit a shot and change its settings (See Tutorial 2: 
Editing Shots). 

Switching Between Shots
Individual shots are displayed in the Layers. The Transition Controls are located just 
below the Live Broadcast Area where the two default transitions are shown: Cut and 
Smooth.

Replacing a shot in the Live Broadcast Area with a shot in the Preview Area is called 
“taking a shot live.”

See Layers and Transition Controls.

1. Click the Ripples shot in the third layer.
The Ripples image fades in on the Live Broadcast Area. A “fade action” occurred 
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when you clicked on Ripples. This is because the Smooth fade is the default 
transition.

2. Click the shot labeled Clear Layer.
The Ripples image fades to black. The Clear Layer shot enables you to display black 
video.

Note: Wirecast does not support a true dissolve transition. The Smooth fade transition 
is the transition closest to a dissolve. 
If you switch from shot “A” to a shot that contains shot “A,” the Smooth fade 
interpolates the difference between the two shots and animates the changes. This 
makes a shot element larger or smaller, and changes its position as needed.
However, if you switch from shot “A” to an entirely different shot “B,” then the Smooth 
transition simply fades between the two shots.

3. To make the cut your default transition, select the Cut control.

4. Click the Ripples shot in the third layer.
The Ripples image cuts in on the Live Broadcast Area.

When you select Cut as the default transition, switching from shot “A” to shot “B” simply 
cuts from the first shot to the second. When Smooth is selected, transitions fade in and 
out, as you just saw.

Transitions
You can assign a maximum of three transitions to the Transition Controls, but more than 
three transitions are available to you. To select a different transition, click the small 
arrow on the right side of any of the transition buttons. When the list of transitions 
appears, select a transition to assign to that button. You can also click the transition 
button itself and drag the mouse downward to display the menu of transitions.

1. To change the left transition button from Cut to Bands, click the Cut button and 
drag downward until the menu appears. Select Bands from the menu. Bands should 
now be displayed as the left button.

2. Now click back and forth between the River and Ripples shots using Bands.

You can use these keyboard shortcuts for the two default transition buttons: Ctrl+1 and 
Ctrl+2.

Note: The Preferences > General tab enables you to set the number of transition 
buttons that Wirecast displays.

See The Default Layout and Transition Controls.

Transition Speed 
To determine how fast a transition occurs, do the following:

3. Select Switch >Transition Speed. 
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4. Choose a transition speed, from Slowest to Fastest.

Layers 

Note: Before you start this section, select Smooth as your default transition.

You can display several shots in the Preview Area and Live Broadcast Area at the same 
time by placing them in layers, one above another. 

To broadcast a layered shot, do the following:

1. Select the Logo shot in layer 2.

2. Select the River shot in layer 3.

The Live Broadcast Area displays a layered shot containing both images.

See Layers.

Auto Live
So far in this Tutorial, Wirecast has been running in AutoLive mode. Wirecast sends any 
shot you select in a layer automatically to the Live Broadcast Area. This mode is very 
useful for those users who want to set up all of their shots at once and then single-click 
them as they run their presentation.

The disadvantage of this single-click method is that you can’t preview the shot before 
taking it live.

Turn AutoLive Off 
A red LED, next to the Go button is lit when you are in AutoLive mode.

See Transition Controls.

1. For this tutorial, turn off AutoLive. Select Switch > AutoLive.
Wirecast de-selects AutoLive. A dialog box informs you that AutoLive is off.

2. Click OK in the dialog box to continue.

3. Click the Ripples shot.
Notice that Wirecast doesn’t send Ripples to the Live Broadcast Area. That is because 
AutoLive is turned off.

4. Now, click the Ripples shot, and then click the Go button.
Wirecast sends the Ripples shot to the Live Broadcast Area.

Note: When AutoLive is off, you must click the Go button (or press Ctrl+G) to display 
the selected shot in the Live Broadcast Area.
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Multiple Changes
A benefit of having AutoLive off is that you can make several changes to your shot first, 
and then have all changes sent to the Live Broadcast Area at the same time. 

Do the following:

5. Verify that AutoLive is off.

6. Click Sample Title in Layer 1.

7. Click Clear Layer Shot in Layer 2, and then click the Ripples Shot in Layer 3.

8. Click the Go button (or Ctrl+G)
Wirecast takes the Ripples and Sample Title shots live at the same time.

Preview 
One problem you may have noticed while running this tutorial is that you can’t see the 
changes you are making before broadcasting them. To solve this problem, Wirecast 
enables you to see a preview of what you broadcast.

1. Select Layout > Show Live and Preview.
Wirecast displays the Preview Area to the left of the Live Broadcast Area. The Preview 
Area uses a green LED to identify it. The Live Broadcast Area uses a red LED to 
identify it. These two colors (green and red) are also used to identify which shots 
are associated with the Preview or Live areas.

2. Click the River shot on Layer 3.
Wirecast displays the River shot in the Preview Area. When shots are selected they 
display a green or red LED to indicate selection for Preview Area or Live Broadcast 
Area.

3. To send the River shot to the Live Broadcast Area, click the Go button.

4. To remove the title from the River shot in the Preview Area, click the Clear Layer shot 
in Layer 1.

5. Turn on the Live/Preview Swap option by selecting Switch > Live/Preview Swap 
(check mark displayed). Notice that the Go button displays a double-arrow, 
indicating that the Live/Preview Swap option is on.

6. Select the Ripples shot and click the Go button to send the Ripples shot to the Live 
Broadcast Area.
Notice that the Ripples and River shots have swapped areas. Also, the shot LEDs 
have changed color. The green shot LEDs indicate all shots included in the Preview 
Area and the red LEDs indicate the shots included in the Live Broadcast Area. You 
can view the shot that is live as you prepare your next shot in the Preview Area.

Double-arrow
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Tutorial 2: Editing Shots
The first tutorial explained various ways in which you can use existing shots. However, 
you can also create and edit shots during a broadcast. This tutorial demonstrates how 
to edit your shots.

1. To edit a shot, double-click its icon in a layer.
Wirecast opens the Shot Editor panel. The Shot Editor has six tabs: Shot Layers, Shot 
Layer Properties, Audio, Chroma Key Properties, Smooth Transition Properties, and 
Additional Source Properties.

See The Shot Editor Window.

2. Practice editing a shot using the various options in the Shot Editor Window tabs.

Red LEDs show Live Broadcast Area 

Ripples and River shots swapped

Green LEDs show Preview Area shots
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Tutorial 3: Broadcasting
This tutorial demonstrates how to setup and broadcast your Wirecast presentations. 
You can broadcast to a specific computer (Unicast), multiple viewers (Multicast), or 
even record your broadcast to disk.

There are two main components for broadcasting your presentation (or saving it to 
disk): encoding and selecting a destination.

You need to decide how you are going to encode your broadcast. Encoding is the type 
of compression used (JPEG, MPEG4, etc.). Wirecast comes configured with many 
common encoding options. (See The Encoder Presets Window for details.).

A destination for the broadcast must be selected. You can send it to a server for 
broadcast or save it to disk.

Streaming
1. To start streaming, click the Stream button.

In the Control/Status bar, the Stream icon blinks until a connection is made. Once you 
are connected the Stream icon turns green. If you can’t connect, Wirecast displays an 
error message. See Control/Status Bar.

Connection strength is indicated by how many bars are displayed in the Stream icon. 
Fewer bars indicates a weaker (slower) connection.

If the connection is ever broken, a no connection icon is displayed in place of the bars.

        

When the connection recovers, the no connection icon is replaced with green bars.

2. Click Stream again to stop streaming.

3. (Optional) You can also record your broadcast by clicking Record.

While streaming, the streaming status is displayed at the top of the default layout.

       

If you are streaming to Facebook, additional statuses are displayed on the right side of 
the status bar.

No connection icon

Streaming 
time

Recording 
time

ISO Recording 
time

Various 
reactions

Number of 
viewers
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Windows, Controls, and 
Menus

You create broadcasts through the various windows, controls, and menus of Wirecast.

Topics
■ The Default Layout

■ Control/Status Bar

■ Preview Area

■ Live Broadcast Area

■ Transition Controls

■ Final Mix Audio Panel

■ Mode Selection Buttons

■ Layers

■ Window Controls

■ Add Shot Window

■ The Shot Editor Window

■ The Audio Mixer Window

The Default Layout
When you create a new document, Wirecast displays the document in the default 
layout. The main elements of the Wirecast layout are labeled in the following screen 
shot, and are described below.
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Figure 1. Wirecast default layout

Control/Status Bar
Control buttons and status information are displayed at the top of the default layout.

    

Wirecast displays the following controls and statistics:

Stream button

When clicked, Wirecast begins streaming.

Streaming time

Total cumulative time the document has been streamed. This value does not reset 
when you start/stop the broadcast. If you save portions of the broadcast to disk, 
Wirecast still displays the total cumulative time.

Menu Bar

Control/Status Bar

Preview Area

Live Broadcast Area

Layers

Final Mix Audio Panel

Mode Selection 
Buttons

Transition ControlsGo button

Stream button

Recording time

ISO record time

Record button
Streaming time

ISO Record

Display 
Preview Only

Display Live 
Only

Display Preview 
and Live

Multiviewer/Secondary Live 
Output button
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Record Button

Click to begin recording.

Recording Time

This displays how long you have been recording. This value does not reset when you 
start/stop the broadcast. It is cumulative.

ISO Record

Click to begin ISO recording.

ISO Record Time

Displays the ISO recording time.

Multiviewer/Secondary Live Output Button

Opens the configuration window if you haven’t already configured your displays. Once 
you've configured your displays, this button places the windows on your displays as 
configured.

Display Buttons

These three buttons enable you to choose to display the Preview Area, the Live 
Broadcast Area, or both in a divided display.

Note: To avoid decrease in video quality, Wirecast should not be used at CPU usage 
above 80%. See the Telestream Website for suggested configurations. You can also 
view streaming statistics by selecting Output > Show Statistics.

Preview Area
Displays the selected shot as it would appear when broadcast, without broadcasting 
the shot. When the shot in the Preview Area is selected, Wirecast outlines the preview 
with a control frame for resizing and rotating the shot.

See Viewing the Preview Area, Viewing a Shot in the Preview Area, and Resizing or Rotating 
a Shot.

Live Broadcast Area
The Live Broadcast Area shows the un-encoded shot currently being encoded and 
broadcast. Also, you can play, pause, or scrub clips displayed in the Live Broadcast Area 
while they are broadcast.

See Switching with Preview and Single-Click Switching with AutoLive.
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Transition Controls
Wirecast displays up to three transition buttons. You can configure each to present one 
of many possible types of transitions. If, for example, Smooth is selected (button 
darkened), clicking Go executes a smooth transition to the new shot.

See Setting the Number of Transition Buttons and Determining the Transitions for the 
Transition Buttons.

Final Mix Audio Panel
The Final Mix Audio panel enables you to control the output volume level, mute audio 
output, and mute the line-out feed for Preview and Live windows.

    

The Preview and Live Volume control enables you to adjust the audio volume for 
Preview and Live separately.

The Live Mute button mutes the Live Broadcast Area audio (what your viewers hear). 
Even when you mute the output, the encoder still generates audio but the output 
remains silent.

Note: If you do not want to broadcast audio, modify the encoder presets to not 
process audio through the encoder. See Encoder Presets.

The Preview Line-Out Mute button and Live Line-Out Mute button control local volume 
(what you hear), not broadcast volume. When Line-Out is muted, audio is not sent to 
your headphones or speakers, but your viewers still hear the audio. The two controls 
are mutually exclusive. You can’t have both on at the same time, but you can mute 
both.

Live Volume 

Live Mute button

Live Line-Out 
Mute button

Live Decibel scale

Preview Volume 

Preview Line-Out 
Mute button

Preview Decibel scale
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See Controlling or Muting the Final Audio Mix Level and Displaying or Hiding the Final Mix 
Audio Panel.

Mode Selection Buttons
Button containing green and red dots

When clicked, Wirecast displays both the Preview Area and the Live Broadcast Area.

Button containing green dot

When clicked, Wirecast displays the Preview Area.

Button containing red dot

When clicked, Wirecast displays the Live Broadcast Area.

Note: These three buttons work the same as three of the options in the Layout Menu. 
See Layout Menu..

Layers
The horizontal bars towards the bottom of the screen are the layers. You can make 
more layers visible. Also, you can add, modify, and play shots from the layers.

By default, Wirecast displays five layers. Each layer can contain multiple shots. A red LED 
indicates that a shot is Live.

Wirecast allows you to put shots on any of the layers. Layering shots enables Wirecast to 
superimpose them, from the lowest layer to the highest, to form a single visual image 
during broadcast.

By default, Wirecast displays five layers. Each layer contains shots that can be selected 
by clicking a shot. A red LED indicates that a shot is selected. When a shot is selected it 
is displayed in the Live Broadcast Area. If you select multiple shots (by selecting a shot 
on more than one layer) Wirecast displays all of them in the Live Broadcast Area.

Wirecast displays Layer 1at the top, Layer 5 at the bottom, and the other layers, in order, 
between them. The order of layers determines the order of superimposition in the Live 
Broadcast Area. If you place a video shot on Layer 5 and a title on Layer 1, Wirecast 
superimposes the title over the video.

See also Viewing a Layer in a Layer Window.

Window Controls

Transition Controls
There are three Transition buttons. You can configure each to present one of many 
possible transition types. Typically, the two configured transitions are: Cut and Smooth. 
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When Smooth is selected (button darkened), any transition executed by clicking Go is a 
smooth transition.

Note: Preferences > General enables you to configure how many buttons you want 
displayed (between 0 and 3).

Changing Transitions
Click the Cut button to make it the current transition type.

You can also select one of the two buttons by pressing Ctrl+1 or 2 keys for the two 
transition types displayed.

If you click the down-arrow on the right side of any of the transition buttons, you can 
select a new transition to assign to that button.

Go Button
When clicked, Wirecast executes the transition selected, broadcasts the shot selected, 
and displays it in the Live Broadcast Area.

If AutoLive is enabled, the Go button appears with a red dot. When AutoLive is enabled, 
simply selecting a shot--without clicking the Go button, broadcasts the shot.

With AutoLive enabled, clicking the Go button updates the live shot with any changes 
you have made to it with the Shot Editor. If you have made no changes to the live shot, 
clicking the Go button does nothing when Wirecast is in AutoLive mode.

With AutoLive disabled, you can make several changes to your broadcast without your 
viewers seeing the change. This is most useful when an engineer runs your broadcast.

See Single-Click Switching with AutoLive and AutoLive.

Playlist Controls
Playlists provide some basic playback controls, located at the bottom of the Playlist tab 
window. You can transition to the previous or next shot in the list, set playlist behavior, 
shuffle the playlist order, and more.

Duration
Transition to 
previous shot

Transition 
between 
shots

Transition to 
next shot

Set Playlist 
behavior

Number of 
shots

Resume 

Shuffle 
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Number of Shots

Displays the current number of shots in the playlist.

Duration

Displays the duration of the playlist shots.

Resume

When checked, if you exit the playlist, when you return the playlist will resume playing 
at the location (same shot) as when you exited.

Shuffle

Click to shuffle the order of the playlist shots. 

Transition to previous shot

Transitions to the previous shot in the playlist if the playlist is currently live.

Transition to next shot

Transitions to the next shot in the playlist if the playlist is currently live.

Set Playlist behavior

Sets the behavior of the playlist when the last shot in the list has been played. A check 
mark indicates what menu item (behavior) is selected.

• Loop transitions back to the first shot, endlessly.

• Hold stays on the last shot. If the last shot is a clip, the last frame in the clip is dis-
played. If the last shot is a live shot, the live source stays active. If the last shot in a 
Playlist is a video clip Shot, it will obey the rules set for the video clip in the Media 
Properties Inspector tab under Source Properties. However, it will hold the Playlist 
on that last Shot if Set Playlist Behavior is set to “Hold”. Therefore, if you want to see 
the last video in the Playlist pause on the last frame, you must set When Finished to 
“Hold” under Source Properties, in addition to setting the playlist behavior to 
“Hold”. If you set When Finished to “Loop”, under Source Properties, the last video in 
the Playlist will continue to loop. 

• Available Shots transitions to another shot on the same layer. All available shots are 
listed as menu selections. (In the example shown, the only available shot is “Logo”.)

• Previous Live Shot transitions back to the shot that was live before the playlist began 
playing.

• Current Preview transitions the contents of Preview to the Live Broadcast Area.

Transition between shots

Sets the transition to use when switching between shots.
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Playlist Countdown Timer Display
Wirecast displays a countdown timer below the Preview Area or Live Broadcast Area 
whenever you play a video shot or playlist. If you play multiple video shots, click the 
gear menu icon and select the shot to associate with the countdown timer.

Add Shot Window
The Add Shot window provides a way to add sources, such as live sources, file sources, 
the Remote Desktop Presenter program, shot graphics, shot audio, and shot templates. 
Click the Plus Button (+) to open the Add Shot menu.

When Wirecast displays the Add Shot menu, select a shot category, select the type of 
shot to add. Modify the shot if desired and allowed. To add a shot to a layer, click the 
Add “+” button in a layer.

To add a source to the Favorites menu, select the source and click the star icon.
Wirecast changes the color of the star to white and adds the source to the Favorites 
menu.

Video Capture
System Device

Select a system device.

See NDI Devices in the Shot Layer Properties Tab.

• Wirecast Gear Video Inputs  If you using Wirecast Gear (and have an active 
license) all available video inputs will be listed.

Gear icon
Countdown timer

Gear menu
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Audio Capture
System Device

Select a system device. 

See NDI Devices in the Shot Layer Properties Tab.

• ASIO Audio Capture Select an ASIO audio capture device and click the Add button. 

System Audio Capture

Select an audio capture device. WASAPI Audio Capture Select a WASAPI capture 
device and click the Add button.

Source Name Displays the name of the source. To change the source name, enter a 
new one.

Audio Delay Enter the amount of time (in seconds, as short as 1 ms) to delay the audio 
signal to sync it up with a video source.

Monitor Click the Monitor icon to cause audio to play through your monitor output. 
The icon is gold when selected (turned on). If unselected, audio will not play through 
the monitor output for this source. Selected is the default.

Media Files
Browse Disk

Select to navigate to a media file.

Stock Media Library

Select to display the Stock Media Library window.

A Media File is a video clip or a picture. To open a Media File source, select Media Files 
from the source menu in the shot window, and then navigate to your file. You can also 
click the Add Media File button at the bottom of the Add Shot window.

Media Files have the following settings:

Source Name

Displays the name of the source. To change the source name, enter a new one.

In Point

Click Jump to move the play head to the In Point in the media file. Set the In Point either 
by dragging the In Point icon to the desired beginning position on the play bar, or by 
entering a value into the In Point field.

Out Point

Click Jump to move the play head to the Out Point in the media file. Set the Out Point 
either by dragging the Out Point icon to the desired end position on the play bar, or by 
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entering a value into the Out Point field. The green triangle shows the current location 
of the Play Head.

When Finished

Select what happens when the media finishes playing. Loop causes the media to begin 
playing again. Hold causes the media to stop and hold the last frame in the Live 
Broadcast Area. Remove causes the media to be removed from the Live Broadcast Area 
when it finishes playing.

Begin playing when media becomes Live

When checked, the media begins playing as soon as it is made Live. 

Remember position even when not Live

When checked, the media will always start playing where ever it was playing when it 
was stopped, even if it was removed from the Live Broadcast Area and made Live again. 
When unchecked, the media will start from the beginning every time it is taken Live.

Set Default

Click to set the media display to default settings.

Live Playback

Changes are live. When you select this option and your shot is live, Wirecast displays 
any action you take in the Preview Area--such as playing, pausing or scrubbing--in the 
Live Broadcast Area, and broadcasts the action live.

Note: If you use this feature to pause or scrub media in the live broadcast, it's usually 
best to uncheck "Begin playing when media becomes live."

WC Gear Inputs
If you are using Wirecast Gear 300/400 series hardware, the Wirecast Gear Video Inputs 
appear in the Shot Selection menu.

After a WC Gear shot is created, you can set up the shot using Wirecast Gear controls.

Audio Input Select the audio input (if any) from the pull-down menu.

ASIO and WASAPI Sources
Any ASIO or WASAPI source on your local network will be discovered by Wirecast and 
listed under Capture Devices in the Source Input Menu. These devices are generally 
used with multi-track audio outputs. ASIO Audio Capture is a very low latency 

In Point icon Out Point icon

Play Head location
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professional audio capture API. It is used to connect to professional audio interfaces. 
WASAPI Audio Capture is also a low latency audio capture API. It replaces the old 
DirectShow-based audio capturing.

Stock Media Library
When you open a Stock Media Library file, Wirecast displays a window presenting 
Terms and Conditions. Read the Terms and Conditions, check the I Agree checkbox, and 
click the Proceed button. Wirecast displays this agreement window only the first time 
you open a Stock Media Library file.

You can also select Stock Media Library to open the Stock Media Library window. Use 
Source Type and Left/Right buttons to navigate to a media file, then click Download to 
include it as a shot.

Source Type

You can toggle on/off any type of media to include in the display: Video, Images, and 
Audio.

Search

Enter key words to display just the media files including these words. The display is 
updated as your enter words.

Left/Right arrows

Click the arrows to move to the next or previous set of Stock Media files.

Play button

Click to begin playing the selected media file.

Source Type Search Left/Right arrows

Play button

File marker

File Type

Download 
button
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File marker

Move the marker to view the media file quickly.

Download button

Click to download the selected media file into a shot.

Network
iOS Cam

Select an IOS Camera device, or an iOS camera through the Wirecast Go iOS app.

Rendezvous

Select to create a new Rendezvous session, or select to reconnect to a previously 
created session.

Web Display

Creates a new Web Display shot.

See Web Page Properties.

Web Stream

Creates a new Web Stream shot.

See Web Stream Properties.

NDI(R) Source

Select any NDI-capable devices on your network.

Web Page Properties
Web Page shows a web source defined by a web address (URL). To open a Web Page 
source, select Web Page from the source menu in the shot window. Web Page 
Properties have the following settings.

Name

Displays the name of the source. To change the source name, enter a new one. 

Audio Delay

Enter the amount of time (in seconds, as short as 1 ms) to delay audio.

Video Delay

Enter the amount of time (in seconds, as short as 1 ms) to delay video. 

URL

Displays the web address (URL) of the source. To change the address, enter a new one. 

Width/Height

Displays the width and height of the display source. To change the width or height, 
enter a new value.
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Transparent Background

Check to make the background transparent in your shot.

Shutdown when inactive

Check to turn off the audio and disable it from the shot when playing videos. 

Override CSS

Enter Cascading Style Sheet code to override the default code for this web display.

Monitor

Click the Monitor icon to cause audio to play through your monitor output. The icon is 
gold when selected (turned on). If unselected, audio will not play through the monitor 
output for this source. Selected is the default.

Web Stream Properties
The Web Stream option allows RTMP, RTSP, MMS, or HTTP streams to be taken directly 
into Wirecast. This is useful for incorporating remote IP Cameras or other network 
streams into a broadcast. Sources are automatically detected and are also identified by 
IP Camera Profile. To open a Web Stream source, select Web Stream from the source 
menu in the shot window.

Web Stream Properties has the following settings.

Name

Displays the name of the source. To change the Name, enter a new one.

Audio Delay

Enter the amount of time (in seconds, as short as 1 ms) to delay audio.

Video Delay

Enter the amount of time (in seconds, as short as 1 ms) to delay video.

URI

Enter the address of your input stream. (For example: rtsp://127.0.0.1:8080/
my_stream.sdp, or http://10.0.0.1/my_stream, or rtmp://hades.telestream.net:1935/live/
myStream).

Username

Enter your username for your URI stream.

Password

Enter your password for your URI stream.

Buffer

Enter a buffer time in seconds.

Reconnect

Click to reconnect the Web Stream source.
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Apply

Click the Apply button to update any changes.

Timestamps

Select Provided by source, or Provided by Wirecast.This setting allows you to use 
timestamps embedded in the source, or use timestamps generated by Wirecast. 
Timestamps are used to synchronize devices. Many sources don't provide completely 
accurate timestamps, resulting in sources out of sync with each other (i.e. audio and 
video not syncing). 

Select Provided by Wirecast to ignore the timestamps coming from the source, and 
instead generate new timestamps. However, the risk is that if the system is under a 
heavy load, the generated timestamps could be impacted, and end up arriving late. The 
default setting is Provided by source.

Deinterlacing

Select None, or Blend Fields.

Dynamic Range

Select Default, Full or Limited.

Monitor

Click the Monitor icon to cause audio to play through your monitor output. The icon is 
gold when selected (turned on). If unselected, audio will not play through the monitor 
output for this source. Selected is the default.

Screen Capture
Remote Desktop Presenter

Creates a new Remote Desktop Presenter shot.

See Remote Desktop Presenter Properties.

Screen Capture

Creates a new Screen Capture shot of any monitor or window on your computer. 

See Screen Capture Properties.

Note: When in screen-capture mode, some apps take control of your mouse and 
make the cursor invisible. To reduce the capture window size and regain use of your 
mouse, press Alt + Tab.

Remote Desktop Presenter Properties
The Remote Desktop Presenter (RDTP) is a utility application that enables Wirecast to 
broadcast the desktop of any computer running the Telestream Desktop Presenter 
program. To open a Remote Desktop Presenter source, select Remote Desktop Presenter 
from the source menu in the shot window.
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Remote Desktop Presenter is normally auto-detected by Wirecast and is automatically 
added to the list of sources. However, if a RDTP is not detected, or if you want to add 
one in a remote location you can manually add it by selecting New Remote Desktop 
Presenter from the Source menu in the default layout.

Remote Desktop Presenter Properties have the following settings.

Source Name

Displays the name of the source. To change the Source Name, enter a new one.

Audio Delay

Enter the amount of time (in seconds, as short as 1 ms) to delay audio.

IP Address

Enter an IP address of the target computer.

Enable Audio When checked, the audio from the remote desktop is enabled.

Apply

Click the Apply button to update any changes.

Monitor

Click the Monitor icon to cause audio to play through your monitor output. The icon is 
gold when selected (turned on). If unselected, audio will not play through the monitor 
output for this source. Selected is the default.

Screen Capture Properties
A Screen Capture displays any monitor or window on your computer. To open a Screen 
Capture source, select Screen Capture from the source menu in the shot window. Screen 
Captures have the following settings.

Name Displays the name of the source. To change the source name, enter a new one. 

Audio Delay Enter the amount of time (in seconds, as short as 1 ms) to delay audio.

Video Delay Enter the amount of time (in seconds, as short as 1 ms) to delay video.

Capture Video Check to enable Capture Type, Show Cursor, and fps settings (described 
below).

Capture Type   Select Monitor (captures your entire monitor), Window (captures the 
currently selected window), or Game (captures the game currently played on your PC). 
If you select Game, you can also configure how your game is captured by selecting 
options offered under Select Window/Monitor (described below).

Anti Cheat Support Enables anti-cheating support for game capture.

Show Cursor Check to show the cursor in your streaming. Uncheck to hide it.

fps Select the FPS, from 10 to 60 frames per second as the capture rate. An FPS of 60 is 
the best frame rate, but it requires greater streaming bandwidth.
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Capture System Audio Check to capture system audio when streaming. Uncheck to 
mute the audio.

Select Window/Monitor   Click the Configure button to display the Select Window 
dialog. If you selected Game for your Capture Type, Wirecast displays a configuration 
window with the following options:

– Capture Any Full Screen Game Check this box to automatically capture a game 
running in a full monitor screen, or running in a full screen of a window.

– Support Multiple Video Cards/SLI Check this box if you have a Windows system 
with multiple discrete GPUs and are experiencing problems capturing a game. 
(Performance of the capture may be slower than when running on a single GPU.)

– Capture Third Party Overlays Check this box to capture overlays rendered on 
top of a game that are generated by applications external to the game. (For 
example, the Steam in-game overlay.

Choose Audio Device Click the Configure button to display the Select Audio Device 
dialog, then select an audio device from the drop-down menu.

Note: Some apps, when screen captured, take control of your mouse and the cursor is 
not displayed. You can, at any time, press Alt + Tab keys to reduce the capture window 
size and enable you to use your mouse.

Dynamic Range Select dynamic range setting: Default, Full or Limited.

Monitor Click the Monitor icon to cause audio to play through your monitor output. 
The icon is gold when selected (turned on). If unselected, audio will not play through 
the monitor output for this source. Selected is the default.

See Screen Capture.

Overlays
Clock

Creates a shot that displays time.

See Clock Properties.

Image Carousel

Creates a new Image Carousel shot that shows a sequence of images. 

See Image Carousel Properties.

QR Code Generator

Creates a QR code display to present to your viewers in a live broadcast.

See QR Code Generator Properties. 

Scoreboard

Creates a new Scoreboard shot.
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See Scoreboard Properties.

Text

Creates a new Text shot.

See Text Shot Properties.

Title

Opens a dialog for adding titles and lower thirds. The title library includes over 25 
customizable animated titles. In the dialog, you can see all the available title designs. 
You can search for a title and filter your search using various criteria. You can preview 
the intro and outro animation, and you see how the title fits on the screen. 

You can revise titles in your project in the Title Properties tab.
If your project contains titles made with earlier versions of Wirecast, those legacy titles 
continue to appear in your project. To access the legacy titles, click the three dots in the 
upper-right corner of the Add Source dialog, and choose "Display Deprecated Sources." 
Wirecast displays the names of animated titles with “Title...” at the beginning. Wirecast 
displays the names of legacy titles with “Title (legacy)” at the beginning.

See Properties for Titles (Animated).

Text Shot Properties
Text displays a text phrase. To open a Text source, select Text from the source menu in 
the shot window. Text Properties have the following settings.

Name

Displays the name of the source. To change the Source Name, enter a new one.

Width/Height

Displays the width and height of the display source. To change the width or height, 
enter a new value.

Mode

Select the source of your text: Text (directly entered) or File (navigate to a text file), or 
RSS (ticker tape RSS feed).

If you select Text, enter your text in the text box below the source selector.

If you select File, enter a file name in the File Path box displayed, or click the navigation 
button (three dots) and find your text file. The text from your file will be automatically 
displayed. The file has to contain UTF-8 encoded text in order for it to be rendered 
correctly. Only the first 64KB of the text file will be loaded and displayed. You can also 
check the Keep reading text file continuously to keep the text display in your broadcast 
up to date with file changes.

If you select RSS, enter a URL in the URL box displayed.

Text

Enter text to display.
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File

Click the (...) icon to navigate to the file containing text to display.

RSS URL

Enter the RSS URL where the text to be displayed is located.

Update frequency

Enter the number of seconds between updates.

Keep reading text file

Check to keep reading the text file for changes.

Font

Select the desired font used for your messages. If you select Web Font, a Web Font field 
will display below. You can also select any of the fonts installed on your computer.

Face

Select the font style from the list of combination of bold and italic.

Size

Enter the font size. Click the gear icon to select the type of font size: small, medium, 
large, etc. 

Justify

Enables you to justify the text along the left, center, or right side of the display.

Align

Enables you to align the text at the top, middle, or bottom of the display.

Color

Click the box to open the color selection panel. Select a new text color from the palette.

Wrap

Select wrap mode from the drop-down menu: Word Wrap or Break Wrap.

Scroll

Enter a scroll mode: Non Stop or If it Does Not Fit.

Background

Select Solid, Linear Gradient (line), or Radial Gradient (circle). Click in the color box to 
open the color palette and select a background color. Click the second color box to 
select the gradient color. For Linear Gradient, adjust the slider to set the angle of the 
gradient display. 

Shadow

Check to activate the text shadow slider controls. Click the color box to open the color 
palette. 

Angle

Move the Angle slider to adjust the direction (0 to 360 degrees) the shadow text is 
offset from the actual text.



Windows, Controls, and Menus
Add Shot Window

37

Wirecast User Guide

Offset

Move the slider to adjust the distance the shadow text is offset away from the actual 
text.

Blur

Move the Blur slider to adjust the amount of blur in the shadow text.

Properties for Titles (Animated)
A title is text displayed in a banner window. Wirecast offers a wide variety of animated 
lower thirds and titles. To open a title source, select Title... from the Add Source menu.

Animated titles have the following settings:

Left/Right arrows

Click to view the previous page, or next page, of titles.

Search

Enter name of title desired.

Filters

Click to open options for filtering your view of the titles.

Scale to Fit/Show Preview

Click to view either the title scaled to the whole screen or placed in its live position.

Tags

Displays identifying tags for the title.

Lines of Text

Displays the number of lines of text in the title.

Custom Colors

Displays the number of custom colors in the title.

Intro Duration

Displays the length of the intro animation.

Animate Intro

Click to preview either the intro animation.

Outro Duration

Displays the length of the outro animation.

Animate Outro

Click to preview the outro animation.

Note: Some title styles have customization sections for Subhead 1 and Subhead 2.
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Properties for Legacy Titles

Note: To access legacy titles, in the Add Shot dialog, click the three vertical dots at the 
top right corner of the box. Then select Show Deprecated Sources.

Legacy titles have the following settings:

Name

Displays the name of the source. To change the Source Name, enter a new one. 

Width/Height

Displays the width and height of the display source. To change the width or height, 
enter a new value.

Mode

Select the source of your text: Text (directly entered) or File (navigate to a text file), or 
RSS (ticker tape RSS feed).

If you select Text, enter your text in the text box below the source selector.

If you select File, enter a file name in the File Path box displayed, or click the navigation 
button (three dots) and find your text file. The text from your file will be automatically 
displayed. The file has to contain UTF-8 encoded text in order for it to be rendered 
correctly. Only the first 64KB of the text file will be loaded and displayed. You can also 
check the Keep reading text file continuously to keep the text display in your broadcast 
up to date with file changes.

If you select RSS, enter a URL in the URL box displayed.

Text

Enter text to display.

File

Click the “...” icon to navigate to the file containing text to display.

RSS URL

Enter the RSS URL where the text to be displayed is located.

Update frequency

Enter the number of seconds between updates.

Font

Select the desired font used for your messages. If you select Web Font, a Web Font field 
will display below. You can also select any of the fonts installed on your computer.

Face

Select the font style from the list of combination of bold and italic.

Size

Enter the font size. Click the gear icon to select the size of font.
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Style

Select any combination of Bold, Italic, All Caps, by toggling each button.

Justify

Enables you to justify the text along the left, center, or right side of the display.

Align

Enables you to align the text at the top, middle, or bottom of the display.

Color

Click the box to open the color selection panel. Select a new text color from the palette.

Wrap

Select wrap mode from the drop-down menu: Word Wrap or Break Wrap.

On Change

Select transition type: Fade, Drop In, Drop Out, and Slide. Enter the length (in seconds) 
of the transition time.

Scroll

Enter a scroll mode: Non Stop or If it Does Not Fit.

Direction

Select the direction of the scrolling: Top to Bottom, Bottom to Top, Left to Right, or 
Right to Left. 

Speed

Enter the speed (in pixels per second) that you want your message to scroll through the 
display.

Auto Reverse

When checked, the display reverses the scrolling direction when it reaches the top or 
bottom of the list.

Background

Select Solid, Linear Gradient (line), or Radial Gradient (circle). Click in the color box to 
open the color palette and select a background color. Click the second color box to 
select the gradient color. For Linear Gradient, adjust the slider to set the angle of the 
gradient display.

Shadow

Check to activate the text shadow slider controls. Click the color box to open the color 
palette. 

Angle

Move the Angle slider to adjust the direction (0 to 360 degrees) the shadow text is 
offset from the actual text. 
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Offset

Move the slider to adjust the distance the shadow text is offset away from the actual 
text.

Blur

Move the Blur slider to adjust the amount of blur in the shadow text

Twitter Feed Properties
Twitter Feed displays a list of Twitter messages. Twitter Feed Properties have the 
following settings.

Name

Displays the name of the source. To change the Source Name, enter a new one. 

Width/Height

Displays the width and height of the display source. To change the width or height, 
enter a new value.

Mode

Select the source of your text: Text (directly entered) or File (navigate to a text file), or 
RSS (ticker tape RSS feed). 

If you select Text, enter your text in the text box below the source selector. 

If you select File, enter a file name in the File Path box displayed, or click the navigation 
button (three dots) and find your text file. The text from your file will be automatically 
displayed. The file has to contain UTF-8 encoded text in order for it to be rendered 
correctly. Only the first 64KB of the text file will be loaded and displayed. You can also 
check the Keep reading text file continuously to keep the text display in your broadcast 
up to date with file changes.

If you select RSS, enter a URL in the URL box displayed.

Text

Enter text to display.

File

Click the “...” icon to navigate to the file containing text to display.

RSS URL

Enter the RSS URL where the text to be displayed is located.

Update frequency

Enter the number of seconds between updates.

Font

Select the desired font used for your messages. If you select Web Font, a Web Font field 
will display below. You can also select any of the fonts installed on your computer.

Face

Select the font style from the list of combination of bold and italic.
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Size

Enter the font size. Click the gear icon to select the size of font.

Justify

Enables you to justify the text along the left, center, or right side of the display.

Align

Enables you to align the text at the top, middle, or bottom of the display.

Color

Click the box to open the color selection panel. Select a new text color from the palette.

Wrap

Select wrap mode from the drop-down menu: Word Wrap or Break Wrap.

Scroll

Enter a scroll mode: Non Stop or If it Does Not Fit.

Background

Select Solid, Linear Gradient (line), or Radial Gradient (circle). Click in the color box to 
open the color palette and select a background color. Click the second color box to 
select the gradient color. For Linear Gradient, adjust the slider to set the angle of the 
gradient display.

Shadow

Check to activate the text shadow slider controls. Click the color box to open the color 
palette. 

Angle

Move the Angle slider to adjust the direction (0 to 360 degrees) the shadow text is 
offset from the actual text. 

Offset

Move the slider to adjust the distance the shadow text is offset away from the actual 
text.

Blur

Move the Blur slider to adjust the amount of blur in the shadow text.

Scoreboard Properties

 

Scoreboards allow you to add a scoreboard graphic to your broadcast that can be 
dynamically updated. Multiple scoreboards can be added. Unlike most other elements 
in Wirecast, changes to the Scoreboard go live instantly without requiring a transition. 
Once the scoreboard is live, the preview image is exactly as it is seen in your broadcast. 
To open a Scoreboard source, select Scoreboard from the source menu in the shot 
window. 

PRO
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Scoreboards Properties have the following settings.

Source Name

Displays the name of the source. To change the Source Name, enter a new one. 

Scoreboard 

Select how the scoreboard will look using two drop-down menus. The upper menu 
selects the scoreboard style: Pipe, Shade, Corner, etc. The lower menu selects how the 
display fields are laid out: Basic, Right Stats, or Bottom. 

Home/Visitor/Score

The Home, Visitor, and Score fields contain the home and visitor team names and their 
current score. The three icons to the right of these fields control the text alignment, font 
size, and font color. Click on each icon to open its control window.

BG Color

Sets the background color for the Home or Visitor field display. Click the color icon to 
open the control window.

+1, +2, +3

Click these score increment buttons to increase the Home or Visitor score display.

Field 1-4 

Displays information inside the scoreboard depending on the layout chosen using the 
Scoreboard menus. The three icons to the right of these fields control the text 
alignment, font size, and font color. Click on each icon to open its control window.

Use a Custom Image 

Check to enable the Choose button.

Choose

Click to navigate to the location of your custom image.

Reset

Click to remove a custom image.

Note: Because Wirecast updates the scoreboards dynamically, It is recommended 
that you fill in the additional information fields while using a layout that hides them. 
Then, change to a layout that reveals those fields when ready, otherwise your viewers 
see you typing in those fields live.

There are four hotkeys associated with the Scoreboard.

= Increments Home score

-  Decrements Home score

]  Increments Visitor score

[  Decrements Visitor score
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In order for these hotkeys to be active, the scoreboard must be displayed in the Live 
Broadcast Area and the Wirecast default layout must be in focus (selected as the active 
Windows window).

Clock Properties
A Clock shot displays time. Clock Properties have the following settings.

Name

Displays the name of the source. To change the source name, enter a new one. 

Clock Modes

Select Clock, Countdown, or Stopwatch.

Clock Mode:

Date Select a date display format.

Time Select a time display format.

Countdown Mode:

Mode

Select Countdown from or Countdown to.

Start Time

Enter the time value from which to start counting. 

Start/Stop/Resume and Reset

Click Start to start the counter. When counting, click Stop to stop the counter. When 
stopped, click Resume to start counting again, or click Reset to rest the counter.

Automatically Start

When checked, the counter will start when the shot is taken live.

Format

Select one of the time-display formats from the drop-down menu.

Start, Stop, Reset

Click Start to begin counting down. Click Stop to end counting down. Click Reset to 
reset clock to Timer value.

At Zero

Select either Stop at 00:00 or Start count up clock.

Stopwatch Mode:

Clock mode
Countdown mode

Stopwatch mode
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Start, Stop, Reset

Click Start to begin counting. Click Stop to end counting. Click Reset to reset stopwatch 
to zero.

Display Format

Select time elements to display: Hours, Minutes, Seconds, and Fractional Seconds.

Font

Select font from drop-down menu.

Face

Select face from drop-down menu.

Size

Click the gear icon to select the font size from the menu.

Background

Select Solid, Linear Gradient (line), or Radial Gradient (circle). Click in the color box to 
open the color palette and select a background color. Click the second color box to 
select the gradient color. For Linear Gradient, adjust the slider to set the angle of the 
gradient display. 

Shadow

Check to activate the text shadow slider controls. Click the color box to open the color 
palette.

Angle

Move the Angle slider to adjust the direction (0 to 360 degrees) the shadow text is 
offset from the actual text. 

Offset

Move the slider to adjust the distance the shadow text is offset away from the actual 
text.

Blur

Move the Blur slider to adjust the amount of blur in the shadow text.

Image Carousel Properties
An Image Carousel shot shows a sequence of images. Image Carousel Properties have 
the following settings.

Name

Displays the name of the source. To change the source name, enter a new one. 

Width/Height

Displays the width and height of the display source. To change the width or height, 
enter a new value.
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Change Every

Sets how often the images are changed, in seconds. 

Fade-In Time

Sets how long it takes for each image to fade in, in seconds. Enter zero for 
instantaneous display of images.

Shuffle Images

Check to shuffle the display order of the images. When unchecked, images are 
displayed as they are ordered in the image list. 

Add/Delete/Move Images

Click the plus (+) button to find and add images. Select an image on the list and click 
the minus (-) button to delete it. You can move images up and down the list by 
selecting an image and clicking the up or down arrow.

QR Code Generator Properties
QR Code Generation has the following settings.

Source Name

Displays the name of the source. To change the source name, enter a new one.

Video Delay

Enter the amount of time (in seconds, as short as 1 ms) to delay video. 

Content

Enter the message you want to be embedded in the QR code displayed in your 
broadcast.

Deinterlacing

Select None, or Blend Fields.

Backgrounds
Web Page

Creates a new Web Display shot.

See Web Page Properties.

Solid Color

Creates a new Solid Color shot.

See Solid Color Properties.

Solid Color Properties
Solid Color displays a solid color background. To open a Solid Color source, select Solid 
Color from the source menu in the shot window. Solid Color Properties has the 
following settings.
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Name

Displays the name of the source. To change the Source Name, enter a new one. 

Width/Height

Displays the width and height of the display source. To change the width or height, 
enter a new value.

Background

Select Solid, Linear Gradient (line), or Radial Gradient (circle). Click in the color box to 
open the color palette and select a background color. Click the second color box to 
select the gradient color. For Linear Gradient, adjust the slider to set the angle of the 
gradient display.

Virtual Set Properties

 

A Virtual Set is a pre-built source set, complete with graphics, that simulates a news-
anchor set. For example, you can select a virtual set that displays three layers of decor 
with two live sources. You can use virtual sets as they are, or you can customize them to 
meet your needs.

Virtual Sets have the following settings.

Source Name Displays the name of the source. To change the source name, enter a 
new one. 

Templates
Shot Template

Select Templates from the Add Shot menu.

When Wirecast displays the Templates window, select a template.

Wirecast displays the new template shot in the shot editor.

• Placeholder Shot

See Assigning Media to Placeholders.

Shot Selection Icons 
Each layer contains one or more shot-selection icons.

The shot icons can be made to display any live activity in the source it represents 
(cameras, streaming, etc.).

See Creating a Shot and  Shot Display Preferences.

PRO
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The Shot Editor Window
The shot editor has six tabs: Shot Layers, Shot Layer Properties, Audio, Chroma Key 
Properties, Smooth Transition Properties, and Source Properties.

  

Shot Layers

Enables you to add and delete sources and to change the display order (layering within 
the shot).

Shot Layer Properties

Enables you to change the size, position, and other properties of a shot.

Audio

Enables you to set and monitor the audio level.

Chroma Key Properties

Enables you to configure the source chroma key settings. Each source in a shot can 
have its own chroma key settings.

Title Properties

Enables you to set properties for a title in your shot.

Shot Layers Tab
The Shot Layers tab lists all of the layers in the shot.

Shot Layers tab

Chroma Key Properties tab

Smooth Transition Properties tab

Shot Layer Properties tab

Audio tab

Title Properties tab



Windows, Controls, and Menus
The Shot Editor Window

48

Wirecast User Guide

Note: Source icons appear only when you hover over them.

     

See Adding, Deleting, or Rearranging Layers in a Shot.

Replay Layer

 

The Replay Layer is a placeholder layer that can be added to any shot for the purpose of 
creating a Replay Template Shot. Once the shot is selected in the Replay Settings it can 
be used as a template for any created Replay Shot.

See Creating a Replay Shot from a Layer.

Select source

Move up or 
down

Click the eye or 
speaker icon

Add or remove 
source

Manage layers

PRO
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Shot Layers Properties Tab
The Shot Layer Properties tab enables you to make adjustments to the sources in your 
shot.

Position

Displays the position of the selected source in your shot. Position “0 0” represents the 
middle of the shot area. To move a source, enter new location values. 

Position 

 Rotation sliders

Matte selector

Click Crop arrow

Click Color arrow

Color adjustments

Opacity slider

Crop adjustments

Color reset button

Scale jog wheel

Drop Shadow 
adjustments

Reflection slider

Click Drop Shadow arrow
Check to enable

Defaults and Reset buttons

Click PTZ arrow
Recall a PTZ preset

Click to open PTZ control panel

Size 

Scale to Fit & Reset Position
Fill

Crop reset button

Gear icon
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Size

Displays the size of the selected source in your shot. To resize a source, enter new size 
values. 

Gear icon

Click and select how to size you bounding box: by pixels or percentage.

Scale Jog Wheel

Click and move the jog wheel to change the scale of your bounding box.

Scale to Fit Button

Click to expand the source to its maximum size on the canvas. This may distort the 
display of the source depending on what you have selected in Fill (below).

Reset Position Button

Click to force the source to return to its original size (scale) and rotation positions.

Fill

Select the way the scaling fills the bounding box: 

• Lock Aspect Ratio: Fills the bounding box until one side hits the edge. Will respect 
the aspect ratio, and will not crop your media.

• Lock and Fill Width: Fills the bounding box to its width. Will respect the aspect 
ratio, so media may end up being obscured top to bottom if your bounding box 
height is less than the media height (or will have letterboxing if bounding box is 
larger).

• Lock and Fill Height: Fills the bounding box to its height. Will respect the aspect 
ratio, so media may end up being obscured on the sides if your bounding box 
width is less than the media width (or it will have pillar bars on either side if the 
bounding box is larger)

• Stretch to Fill: Fills your bounding box, does not respect aspect ratio of media, so 
may end up distorting your media.

Note: The Fill feature is not active in Clock, Text, Solid, QR Code or Web Page shots. In 
these shots the image automatically stretches to fill the bounding box.

X Y Z Rotation

Slide the X (Horizontal), Y (Vertical), or Z (Straight-through) axis sliders to rotate the 
source. (See also Reset Position below).

Opacity

Slide the Opacity slider to adjust the degree of transparency of your image.

Reflection

Slide the Reflection slider to adjust the degree of reflection below your image.



Windows, Controls, and Menus
The Shot Editor Window

51

Wirecast User Guide

Matte

A Matte is a mask over a shot. Select a matte by clicking the down-arrow on the Matte 
menu. Default is No Matte. You can also use any media file as a custom matte. To do this, 
create a new shot of the media file you want to use as a matte. This file now appears in 
the Matte drop-down menu where you can select it.

Crop

Click the Crop triangle to open the cropping adjustment pane. Slide the Left, Right, Top, 
and Bottom sliders to crop your source image.

Reset

Click the Reset button to reset the crop controls to their default settings.

Color

Click the Color triangle to open the color adjustment pane. Slide the color controls to 
adjust the color.

Reset

Click the Reset button to reset the color controls to their default settings.

Drop Shadow

Click the Drop Shadow triangle to open the Drop Shadow adjustment pane. Check the 
checkbox to enable the controls.

– Color Click in the color field to open the color palette. Select a shadow color and 
luminance by sliding the vertical and horizontal sliders. Click outside the color 
edit box to close the palette.

– Angle Move the Angle slider to adjust the direction (0 to 360 degrees) the 
shadow text is offset from the actual text. 

– Offset Move the slider to adjust the distance the shadow text is offset away from 
the actual text.

– Opacity Slide the Opacity slider to adjust the degree of transparency of your 
source.

– Blur Size Move the slider to adjust the amount of blur in the drop shadow.

Use As Defaults

Click to set the current drop shadow configuration as the default setting. All future 
enabled drop shadows will be set this by default. Clicking this button does not 
retroactively update previously created shots. Drop shadow settings on individual 
shots can still be changed.

Reset

Click to restore the drop shadow settings back to the default values. You can also 
restore the drop shadow settings to Wirecast application defaults by holding the Shift 
key down and clicking Reset.

PTZ

Click the PTZ triangle to open the PTZ control panel.
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Preset

Click the up and down arrows to find a PTZ preset to recall, then click the Right Pointing 
Arrow button to recall the preset.

Show PTZ Controller

Click to display the PTZ Controller panel.

See PTZ Controller.

PTZ Control in the Shot Layer Properties Tab
You can select PTZ Controller presets associated with a shot layer video source from the 
Shot Layer Properties tab of the Preview Inspector. You configure PTZ Control Presets in 
the PTZ Controller Panel.

To expand the PTZ control panel, click the PTZ triangle. To enable preset recall, check 
the Enable box. To select a preset, enter a preset number or click the up/down arrow 
buttons. Click the Go button (right pointing arrow) to cause the associated PTZ camera 
to recall that preset.

Once you have configured a shot layer with a PTZ Preset, sending that shot to preview 
recalls the preset for the camera. If multiple shots share the same video source with 
different PTZ Presets configured, the shot which is currently live takes precedence over 
subsequent PTZ Preset recall actions, until you drop the shot from the live feed.

When you enable Preset, clicking Show PTZ Controller opens the PTZ Controller panel. 
See Shot Layers Properties Tab.

NDI Devices in the Shot Layer Properties Tab
If you have selected an NDI source, the NDI Source Properties tab will display. In 
addition to the controls above, an NDI source has the following controls.

Video Delay

Enter the amount of time (in seconds, as short as 1 ms) to delay video. 

Bandwidth

Select the bandwidth to use: Highest (max quality), Lowest (max efficiency), or Audio 
Only (video bandwidth not applicable).

GPU Decoding

When checked, incoming sources will use your GPU to process the incoming source.

Timestamps

Select Provided by source, or Provided by Wirecast.This setting allows you to use 
timestamps embedded in the source, or use timestamps generated by Wirecast. 
Timestamps are used to synchronize devices. Many sources don't provide completely 
accurate timestamps, resulting in sources out of sync with each other (i.e. audio and 
video not syncing). 
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Select Provided by Wirecast to ignore the timestamps coming from the source, and 
instead generate new timestamps. However, the risk is that if the system is under a 
heavy load, the generated timestamps could be impacted, and end up arriving late. The 
default setting is Provided by source. 

Deinterlacing

Select None, or Blend Fields.

Dynamic Range

Select Default, Full or Limited.

Monitor

Check the Monitor check box to cause audio to play through your monitor output. If the 
check box is unchecked, audio will not play through the monitor output for this source. 
Checked is the default.

Note: NDI networking requires that your network has port 5353 open for mDNS 
device discovery, as well as one port per video channel (starting from port 5960 and 
onward) transmitted by an NDI source, plus one additional port for messaging.

See Adding NDI™ Sources to Rendezvous.

Audio Properties Tab
The Audio Properties tab enables you to control and monitor audio. You can set the 
audio level, mute and monitor the audio, and map channel outputs.

Volume

Adjust the slider to set the audio volume level.

Pan

Adjust the slider to pan between left and right audio.

Map button

Meter display

Volume slider

Pan control

Speaker icon

Channel controls
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Meter

Monitors the audio level. You can also mute the audio by clicking the audio icon.

Speaker Icon

Click to mute the audio output. Icon turns gray when muted. Click the icon again to un-
mute the audio.

Channels

Select left (L) or right (R) for each channel. Adjust volume slider for each. 

Apply to All

Click to apply the current settings to every instance of the selected source. If you have 
any shot specific configurations in other shots, they will be changed to match what was 
configured when you click this button. This action cannot be undone!

Set as Default

Click to take the current settings and set them as the default configuration. Any time 
this source is added to a shot in the future, it will be created with this configuration.

Reset

Click to reset the default settings. This is useful if you have made changes to the default 
custom settings, but want the defaults set back to the factory default settings. Factory 
defaults are: Chan 1 = Left; Chan 2 = Right; additional channels are unassigned.

Map

Click to open the audio mapping window. Check a square to map an audio channel to 
an audio track. Any audio can be tracked to any or all tracks. However, you will typically 
assign a group of channels to one track and other groups to other tracks.

If you have created a shot using a 16 input device, the mapping window will display all 
16 channels.

Note: Although SDI supports 16 discrete audio channels, Wirecast Pro video out 
currently only supports two channels.

The audio track that is actually used is selected from the Audio Track menu in the 
Output Settings window. You can select only one track. However, if you are recording, 
you can select multiple audio tracks.

Chroma Key Properties Tab
Chrome Key (also called “green screen”) enables you to replace all green areas of your 
display (or any other color you choose) with a background image. For example, if you 
are in front of the traditional green screen, by “keying out” the green and leaving the 
background transparent, you will appear to be in front of your background.

The Chroma Key Properties tab enables you to turn on/off chroma keying and make 
chroma key adjustments. Check the Use box and+ select the type of use: Chroma, 
Luma, or Color Key.
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Use

Check to turn on chroma keying. Uncheck to turn it off. Select the type of use: Chroma, 
Luma, or Color Key.

Color

Click the color square to open the Color Pallet. Select a color to use as the chroma key 
color and click OK. Click the dropper icon to use your mouse to select a chroma key 
color from your screen. Hover over the a desired color in the selected source, and click 
the left mouse button to select that color. All adjustments will be made using the 
selected color as the key.

Key Threshold

Move the slider to adjust how far away from your chosen chroma color you want to 
enable keying. The farther right you move the slider the more variation to the color it 
accepts.

Black Clip

The Black Clip slider allows you to define what is considered “black”. When slider is fully 
left, you have a very thin definition of what black is. The farther to the right you go, you 
start adding more cases of what we consider “black'”. In chroma key, rarely do you want 
to bump the far left side to the right.

White Clip

The White Clip slider allows you to define what is considered “white”. Slide both all the 
way to the right, for a very thin definition of white. The more you increase the range, 
the more you add to what you consider to be full intensity brightness. In chroma key, 
rarely do you want to bump the far right side to the left.

Spill Suppression:

This slider says: anything that is near green, bump it away from green. Move this slider 
to help take away the green reflection it locates on an edge. This will take everything 
that's green, and take away its greenness.

Solidify:

This slider says: if all the pixels around me seem to be part of the key, then bump up my 
probability of being part of the key. This tends to “solidify” your key. Move the slider to 
the right to bump up the alpha values for pixels surrounded by high alpha values. One 
disadvantage is that the hair on a subject may appear more “blocked” in nature.

Edge Coloring

Move the slider to adjust the level of edge coloring which pull colors from inside of 
keyed object to get rid of halo on an image.

Display

Select display: result of keying, white-alpha channel, or black-alpha channel. This can 
be helpful to get key parameters set correctly.

Luma Key

This lets you key based on its brightness (or Luma value). You have an icon with a white 
background - and you want to get rid of the white background. 
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Color Key

This lets you set the image alpha based on the distance from a given color in the RGB 
space. This is useful for images (logos) that have non-black and non-white 
backgrounds. If the BG is black or white use Luma Key. If it's a plate from a greenscreen/
bluescreen then use Chroma Key. Otherwise, try Color Key.

Alpha Clip

This lets you choose what distance from the key color should be considered  
“foreground”. So anything over a given distance from the key color is “foreground” 
otherwise it's “background”. A range is used so there is a smooth transition from 
foreground to background.

Smooth Transition Properties Tab
The Smooth Transition Properties tab provides control over how objects (image, movie, 
title, etc.) are added or removed in the Live Broadcast Area. Wirecast performs motion 
only  during a Smooth transition. If you are using any other transition, the motion 
settings are ignored.

There are two types of motion. When an object is added to your broadcast it is called 
Build In; When it is removed it is called Build Out. Motion only occurs when an object 
enters or leaves the Live Broadcast Area. For example, if you have two shots, each with a 
foreground and the media in the foreground is the same, then a Smooth transition is 
performed between the foregrounds. However, no motion is performed. Or, if a logo is 
positioned in the top left corner in an existing shot, and it is in the bottom right corner 
in a new shot, when you make the new shot Live the logo smoothly transitions from the 
top left corner to the bottom right corner. But the Build In and Build Out settings are 
ignored. 

However, if you have two shots with a Foreground, but the media in each is different, 
the Build Out is performed for the existing shot, and the Build In is performed for the 
new shot.

Direction Menus

These provide selections of where the Build In comes from (top, bottom, right, etc.) 
when it is added, and where the Build Out goes when it is removed. 

Fade In / Fade Out

Checking these checkboxes causes an object to be added or removed gradually. If 
unchecked, the object is instantly added or removed, much like a cut transition. 

Spin In / Spin Out

Checking these checkboxes causes an object to be added or removed in a spinning 
fashion.

Scale In / Scale Out

Checking these checkboxes causes an object to be added or removed in a scaled 
fashion.
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Apply To All

Click this button to make the Transition Settings the same for all sources in a shot. This 
is useful if you want to make all of your motion the same for all of the elements in the 
shot.

Set As Default

Click this button to make these Transition Settings the default settings for all new shots. 
These default settings will be applied in all future WC documents.

The Audio Mixer Window
The Audio Mixer enables you to monitor and control all of the audio sources from a 
single control panel. This section describes in detail how to use the Audio Mixer.

To open the Audio Mixer window, select Audio Mixer from the Window menu.

The Audio Mixer separates your audio by hardware and shot. Live Input is always the 
first section to the right of the Final Mix control, and it contains all hardware audio 
sources that are live in your streaming event. This includes microphones, audio input 
feeds, cameras, capture cards, Web streams, etc. The remaining audio controls are 
associated with specific shots. 

Final Mix Audio 
control panel

Final Mix 
Audio Level 

Headphone 
Mute 

Final Mix Mute 

Live Sources 
control panel

Final Mix 
display

Source 
selection

Level control 

Level display

 Mute button

Monitor button

 Delay

Channel
FX

Add new FX

Track 
selection



Windows, Controls, and Menus
The Audio Mixer Window

58

Wirecast User Guide

The Monitor button toggles the source audio when monitoring Preview or Live output. 
This does not remove the audio from the output stream or recording. Delay enables 
you to delay the audio as needed, in seconds and milliseconds. Channel enables you to 
select left source only, right source only, or stereo (left and right).

Delay

Enter the amount of audio delay needed (in seconds and milliseconds).

Channel

Select the channel to use: Left, Right, or Stereo (both).

FX

Click the down-arrow to display the audio effects panel.

Add New FX (+)

Click the plus (+) icon to select an audio effect from the drop-down menu.

Delay

L and R Delay adjusts how much delay on each channel. Feedback is how much delay is 
used. Fb Tone is a frequency setting of highs and lows to be delayed. FX Mix is how 
much delay will be added to audio output. Output sets the delay output level.

Dynamics

Thresh sets the threshold of engaging compression. Ratio sets the compression ratio. 
Output sets the compression level. Attack sets the manner in which compression is 
applied. Release sets how compression in released. Limiter sets a max output level on 
the audio. Gate controls (Thresh, Attack, and Release) sets the noise gate that cuts off 
noise at the set level. Mix adjusts how much compression is applied to the audio.

De-ess

Thresh sets the threshold of de-essing. Freq selects the frequency at which de-essing 
will be applied to the audio. HF Drive adjusts the high frequency aspect of de-essing.

EQ

Low, medium, and high adjusts low, mid, and high frequency components in the audio.

Loudness

Loudness adjusts the amount of loudness (raising high and low frequencies) in the 
audio. Output adjusts how much loudness is applied to the audio.

Limiter

Thresh sets the minimum threshold of limiting in the audio. Output sets the amount of 
limiting used in the audio. Release sets the manner in which limiting is released as the 
audio decreases. Attack sets the manner in which limiting is applied. Knee adjusts the 
frequency and shape of point where limiting begins.

Multiband

Listen selects which part of the frequency spectrum to hear: low, mid, high, or all 
(output). L<>M adjusts the cutoff frequency in the low to mid range (87 to 1020 Hz). 
M<>H adjusts the cutoff frequency in the mid to high range (111 to 19606 Hz). L, M, 
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and H Comp adjusts the compression for low, mid, and high frequencies. L, M, and H 
Out adjusts the output for low, mid, and high frequencies. Attack sets the manner in 
which compression is applied. Release sets the manner in which compression is 
released. Stereo adjusts how the left and right channels are separated (width) from 0 to 
200%. Process selects stereo or mono mode.

Noise Reduction

Amount sets the amount that noise reduction is applied.

Level Control

Adjusts the audio level of the live audio output.

Level Display

Displays the levels (left and right) of the live audio outputs.

Mute

Mutes the live audio output.

Monitor

Toggles the monitor audio output in the headphones without effecting the live audio 
output.

Final Mix Audio Level

Adjusts the audio level of the Final Mix audio output.

Final Mix Display

Displays the levels (left and right) of the Final Mix audio outputs.

Final Mix Mute 

Mutes the Final Mix audio output.

Headphone Mute

Toggles the monitor audio output in the headphones without effecting the Final Mix 
audio output.

Source Selection

Click the down arrow to select an audio source from the drop-down menu.

Track Selection

Click the down arrow to select an audio track from the drop-down menu. 

Note: Although SDI supports 16 discrete audio channels, Wirecast Pro video out 
currently only supports two channels.

The Output Settings Window
The Output Settings Window enables you to customize the settings for a destination.
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Destination List

Wirecast lists the last-used destinations in the left-side pane of the Output Settings 
window. Each destination has its own broadcast technology preset, for example RTMP, 
or Windows Media.

Add Button

When clicked, the Add button opens the Select an Output Destination dialog, enabling 
you to add destinations to the destination list.

Remove Button

When clicked, the Remove button opens the Select an Output Destination dialog, 
enabling you to remove destinations from the destination list.

Name

This is an editable field for the name of the output setting. By default, Wirecast names 
the setting for the destination selected.

Destination

This drop-down menu lists all the visible existing destinations.

More Button

This button opens a menu listing all existing destinations, with check boxes for making 
each destinations visible in the Destinations drop-down menu.

First Gear Icon

This drop-down menu lists actions available for the destination selected.

Encoding

This drop-down menu lists the available encoding presets. Each destination preset has 
its own encoding presets. The encoding presets define the codec, aspect ratio, and 
frame rate for each destination. Wirecast provides many encoding presets.

Second Gear Icon

This drop-down menu enables you to view the details for the preset selected, create a 
new preset, or filter the presets listed for the destination selected.

Audio Track Selection

This drop-down menu lists the audio tracks available for the destination selected.

Map Button

This button opens the Multi-Track Input Mapper for the destination and track selected.

Address

This editable field contains the network address for the destination selected.

Port

This editable field contains the port address for the destination selected.

Passphrase

This editable field contains the passphrase for the destination selected.
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Location

This field displays the host location for the destination selected.

See Destinations and The Encoder Presets Window.

The Encoder Presets Window
The Encoder Presets window enables you to select a default encoder preset for your 
output, and to create your own custom presets.

Encoder Preset

This drop-down menu lists all default and custom encoder presets available.

Video Encoding

When checked, Wirecast enables you to customize the video encoding settings shown 
in the Video Encoding pane.

Note: You should match the output to the canvas size as closely as possible to 
preserve video resolution and quality. For example, a 800x600 source results in 
significant loss of quality if an aspect ratio of 640x480 is selected for the output. 
Choosing an output of 720x576, which is much closer in size, helps preserve video 
quality.

Profile

Many encoder presets enable you to select one of three profiles: Baseline, Main, or 
High.

Baseline Profile (BP) Baseline profile is primarily for low-cost applications that require 
additional data loss robustness. This profile is used in some video conferencing and 
mobile applications. It includes all features supported in the Constrained Baseline 
Profile, plus three additional features used for loss robustness (or for other purposes 
such as low-delay multi-point video stream compositing). The importance of this 
profile has faded somewhat since the definition of the Constrained Baseline Profile in 
2009. All Constrained Baseline Profile bitstreams are also considered to be Baseline 
Profile bitstreams, since these two profiles share the same profile identifier code value.

Main Profile (MP) The Main profile is used for standard-definition digital TV broadcasts 
that use the MPEG-4 format as defined in the DVB standard. It is not, however, used for 
high-definition television broadcasts, since the importance of this profile faded when 
the High Profile was developed in 2004 for that application.

High Profile (HiP) The High profile is the primary profile used for broadcast and disc 
storage applications, particularly for high-definition television applications. For 
example, this profile is used by the Blu-ray Disc storage format and the DVB HDTV 
broadcast service.

Audio Encoding (AAC)

When checked, Wirecast enables you to customize the AAC audio encoding settings 
shown in the Audio Encoding pane.
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See Encoder Presets and Encoder Presets.

The PTZ Controller Panel
In this panel you can create a preset group of settings for each camera listed in the 
Camera drop-down menu. You can associate multiple presets for each camera. Also, 
you can switch between devices in the Camera drop-down menu.

Camera

This drop-down list shows cameras available to Wirecast. Selecting a camera updates 
the PTZ Controller window to display the preset VISCA and PTZ configuration for that 
camera. Once you establish a connection to a valid VISCA device, the PTZ Controller 
panel shows the camera's current Pan/Tilt orientation. Changing the Camera source 
changes all the settings in the panel accordingly.

Note: A PTZ camera's VISCA configuration is discrete from the video feed. You can 
associate any available video source with any manually-entered VISCA device 
information. This accommodates a workflow where the camera's video feed is being 
captured via a Capture Card.

Protocol

Select a PTZ protocol from the drop-down menu,

IP Address

Enter the IP address of a valid VISCA-over-IP source on the network. This IP address is 
configured in your camera's network settings.

Port

Enter the IP port for the VISCA connection of the camera. This IP port is configured in 
your camera's network settings.

VISCA Address

Select the correct VISCA Address of the camera. This VISCA Address is configured in 
your camera's VISCA settings.

Status / Reconnect Button

Displays the current VISCA connection status (“connected” or “invalid source”) of your 
camera. Click the Reconnect button to force a reconnection.

Home Button

Click the House icon to reorient the PTZ camera to its default position (default centered, 
no zoom).
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Pan/Tilt

Select the desired pan/tilt control method (Map, D Pad, or Analog Pad) from this drop-
down menu.

• Map – displays an X/Y plane with a yellow cross-hair representing the current Pan/
Tilt orientation of the camera

• D-Pad – Pan the camera by clicking the left and right arrows, and tilt the camera by 
clicking the up and down arrows.

• Analog Pad – Click in the analog circle to reposition the camera pan and tilt.

Zoom

Move the slider to adjust the zoom factor of your camera.
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Note: When the PTZ Controller panel is the selected window, you can press the arrow 
keys on the keyboard to adjust the Pan (left and right arrow keys) and Tilt (up and 
down arrow keys) of the camera. Alternatively the W, A, S, and D keys can also be used 
(W = Up, A = Left, S = Down, D = Right)

Focus

Click the Plus and Minus buttons to adjust the focus of the camera. The yellow button in 
the center toggles auto-focus on and off. Any manual adjustments made to the focus 
will automatically disable the auto-focus.

Exposure

Select the exposure mode from the Exposure drop-down menu.

• Shutter Move the slider to adjust the shutter of the camera. You can only adjust the 
Shutter when Exposure mode is not in auto-focus.

• Iris Move the slider to adjust the iris of the camera. You can only adjust the Iris 
when Exposure mode is not in auto-focus.

Note: Refer to PTZOptics documentation for more details about each mode.

White Balance

Select the white balance mode from the White Balance drop-down menu.

Note: Refer to PTZOptics documentation for more details about each White Balance 
mode.

One Shot

When the White Balance mode is set to One Shot, click this button to adjust the White 
Balance one time only.

Red Gain/Blue Gain

When not in auto-focus mode, you can use these sliders to adjust the red and blue gain 
of the video signal to compensate for white balance issues.

Presets

Enter a preset number and click Save to save current Pan, Tilt, and Zoom configurations 
of camera. To recall a preset, select a preset number by clicking the arrow buttons, then 
click the Recall button.

Note:  If you have Wirecast in the AutoLive mode, you must click the Live button to 
switch between presets on the same PTZ camera. This is a built-in safeguard against 
unintentionally moving the camera while in Live mode.

See Configuring The PTZ Controller, Opening the PTZ Controller Panel, and Controlling a 
PTZ Camera.



Windows, Controls, and Menus
File Menu

65

Wirecast User Guide

File Menu
New

Creates a new, empty Wirecast document.

Open

Displays the Open dialog window for opening a Wirecast document.

Open Recent

Displays up to fifteen of the most recently accessed documents. Every time a document 
is opened or saved it is entered into this list.

Import Media

Enables you to import media into Wirecast. A new shot is automatically created using 
the new media.

Save

Saves the document. If the document has not already been saved, the Save As... dialog 
window is displayed.

Note: Wirecast auto-saves your Stream/recording. All formats (WMV, MOV, MP4) will 
be recoverable in increments of 20 seconds. Any recording less than 20 seconds is 
corrupted. ISO also recovers. In the case of an unexpected shutdown, the recoverable 
video is available in increments of one minute.

Save As

Displays the Save As... dialog window so that the document can be saved using a new 
file name.

Close Window

Closes the currently active Wirecast window. If the window is a document, all of its Shot 
Editor windows are closed as well. If Wirecast is still broadcasting, you are asked to stop 
the broadcast. If the document has not been saved, you are asked to save the 
document before closing.

Preferences Opens the Preferences window. If the Preferences window is already open, 
it is made active.

Exit Closes all documents and then exits. If the broadcast is playing, you are asked to 
stop the broadcast. If a document has not been saved, you are asked to save the 
document before exiting.

Edit Menu
Undo

Reverses your last change in Wirecast. Undo is only available in some windows (such as 
the Preview Area). Wirecast offers an unlimited number of undo actions (within 
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computer memory limitations). Undo information is stored on a per-window basis. 
Also, if you close a window then reopen it, your undo information is lost. 

Redo

Reverses your last undo action. Redo is only available in some windows (such as the 
Preview Area). Wirecast offers an unlimited number of redo actions (within your 
computer’s memory limitations). Redo information is stored on a per-window basis. 
Also, if you close a window then reopen it, your redo information is lost.

Cut

Cuts selected text.

Copy

Copies selected text to clipboard.

Paste

Pastes selected text from clipboard to location of cursor.

Paste as new Consolidated Shot

Pastes selected shots into one consolidated shot. A consolidated shot is a shot created 
from multiple sources.

Select All

Selects all text in the active window.

Edit Shot

Opens the Shot Editor. You can also double-click a shot, or right-click and select Edit 
Shot, to open the Shot Editor.

See The Shot Editor Window. 

Rename Shot

Enables you to rename a shot. You can also right-click a shot and select Rename Shot.

Duplicate Shot

Duplicates the currently selected shot. You can also right-click a shot and select 
Duplicate Shot.

Duplicate Shot Options

Check a source to create a new instance of it when duplicating the shot containing it. 
Multiple selection is allowed.

Delete Shot

Deletes the currently selected shot. You can also right-click a shot and select Delete 
Shot.

Move To Layer

Moves a shot to the selected layer. When shots are created, they are assigned to a 
specific layer. They exist on that layer until they are moved or deleted. You can also click 
and drag a shot to another layer.
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Switch Menu
Go

Performs a transition (same action as clicking the Go button).

Transitions

Wirecast has two transition buttons that can be assigned any transitions (cut, smooth, 
etc.) that Wirecast supports. The Switch menu lists the currently assigned transitions by 
name. These two transitions can also be selected by pressing the control key and either 
the 1 or 2 key. Right-click on either transition to open the operation menu. Select how 
the transition will operate: Ease In, Ease In/Out Ease Out, Linear, or I.

To select which transitions appear in this menu, see Transition Controls.

Transition Speed

Enables you to select one of five transition speeds ranging from Slowest to Fastest.

Manage Stinger Transitions

Enables you to import and use custom transitions that employ transparent 
backgrounds. These transitions are typically created using applications such as Adobe 
After Effects, Apple Motion or ScreenFlow.

Select Switch > Manage Stinger Transitions to display the Stinger Transition Manager. To 
import a transition file, click the plus (+) button and navigate to the location of the file.

Once the transition file is imported, you can preview the transition from shot A to shot 
B by clicking the play button. To set the location of where the shot will change from A 
to B, slide the scrubber to a location in the transition, then click the A/B button.

      

Note: Stinger transitions are stored in the preferences (including the path to the 
media file). This allows the you to re-use transitions in other WC documents. When 
Wirecast cannot find a media file associated with a Stinger transition (file deleted or 

Click play to 
preview

Move scrubber 
to a location

Click the A/B 
button
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moved), the transition will be removed from the transition bank list and the name will 
be highlighted red in the Stinger Transition Manager.

To delete a transition, select it and click the minus (-) button. Click the help (?) button to 
display help instructions (this portion of the user guide). Check (optionally) the Keep all 
video frames in memory check box. When checked, CPU spiking (which can cause 
streaming problems) is prevented, but more memory is used. Click Close to exit the 
Stinger Transition Manager.

To execute a Stinger Transition, open a transition menu and select a Stinger transition. 
Click the Go button to execute the Stinger transition.

AutoLive

Toggles (turns on and off ) the AutoLive feature.

You may want to single-click a shot to make it become live. Alternatively, you may want 
to make several changes to a shot before making it live. You can use either method in 
Wirecast.

When enabled, the AutoLive feature lets you broadcast any shot with a single click. 
When AutoLive is enabled, Wirecast disables the Go button. Clicking a shot in a layer 
automatically places the shot in the Live Broadcast Area.

See Single-Click Switching with AutoLive and Go Button.

Live/Preview Swap

Toggles (turns on and off ) the Live/Preview Swap feature. When on, the Live Broadcast 
and Preview windows trade panes (swap) when the Go button is clicked.

Layer Visibility

Click to open the menu and select a layer to hide or show in your shot. A check mark 
displays when the layer is visible. The shot icon becomes gray when not visible. You can 
toggle on and off the viability of each layer by pressing the Alt+1 through Alt+5 keys.

Disable PTZ Preset Recall

Enables/Disables PTZ preset recall.

See The PTZ Controller Panel.

Note: When you transition to a shot containing an animated title, Wirecast first 
executes the transition, and then performs the opening animation for the title. When 
you clear the title from the shot, Wirecast first performs the closing animation for the 
title, and then executes the transition for the end of the shot.

Media Menu
Start Playing All Movies

Starts playing any movies that are not currently playing.
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Pause All Movies

Pauses all movies that are currently playing.

Shuffle Playlist

Randomly rearranges the order of media in the playlist. 

Show Asset Manager

Displays devices that can be configured. Some devices (cameras, etc.) may be 
configurable. For example, you can configure a USB camera to manually change its 
focus, contrast, brightness, etc. Other devices have multiple inputs you can choose 
(AlchemyTV Card, etc.). 

See Asset Manager.

Note: The Configure Devices menu selection is present only if a device is connected 
to Wirecast. The configuration user interface is provided by the device maker. It is 
beyond the scope of this document to describe all of the features available for all 
devices. See the documentation provided with your device on how to configure it.

Output Menu
Output Settings

Opens the Output Settings window.

Start/Stop Broadcasting

Starts (or stops) broadcasting to the network. 

Start/Stop Recording

Starts (or stops) recording to disk. If you have not yet configured the Output Settings 
for this document, you are prompted to do so. 

Show Recordings

Opens all the folders of all the file directories in the Output Settings.

Multi-Viewer Output

Enables you to setup and use a Multi-Viewer display on and or all monitors. You can 
configure your displays, enable all displays, select a display to be active, or show (or 
hide) all displays when the application is in the background.

Configure Displays 

Select Configure Displays to open the configuration window.

Setup your Multi-Viewer by choosing a Monitor which determines where the Multi-
Viewer will display. Also select the Mode: Multi-viewer, Live Output, or Disabled 
(neither).

Select a Layout which determines how the Multi-Viewer will be displayed. The layout 
choices are: one, two, or four slots. In the Pro version ten or seventeen slots can also be 
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selected. Each panel slot can then be mapped to any source: Preview, Live or any 
existing Shot in your document. Click inside a panel to select a source. Each Monitor is 
configured separately using the Configuration window. So, when you select a different 
monitor, the configuration panel (slots) also change. Additionally, all the monitors are 
automatically numbered. Clicking the Identify Displays button causes each of the 
monitors to display it number on it. 

You can also control how each panel is labeled by making a selection from the Labels 
menu:

Draw Labels Below each Slot

Displays the label below each shot in each panel.

Superimpose Labels Over Each Shot

Displays the label over each shot in each panel.

Do Not Draw Labels

No labels are displayed.

Click on any slot panel to open the source menus, then select a source from the list to 
display it in the slot. Click Identify Display to cause the display number on each display 
to be shown.

Enable/Disable All Displays 

Select to hide or display all of your configured Multi-Viewed monitors.

Select a Display 

Select one of your configured Multi-Viewed monitors to hide or display. Shown below is 
a typically configured monitor with four slots. Audio meters are provided in each view.

Hide All Displays When App is in the Background

When selected, all Multi-Viewer Displays are hidden if Wirecast itself is put into the 
background or minimized. Turning this option off allows the Multi-Viewer outputs to 
stay on if Wirecast is put in the background or minimized.

Note: Multi-Viewer displays can also be disabled by clicking on the Multi-Viewer 
display itself (on its target monitor), and then pressing the Escape (Esc) key.

Secondary Display Live Output

Sends the live program to a secondary device. For example, you can send a live 
program feed to another screen or to a capture card in an external device. If the 
external device has an UVC HDMI capture card, you can capture the live output from 
Wirecast for use in the applications--such as Zoom or Teams--on the other device.

You can use Secondary Display Live Output as an alternative to Virtual Camera/Mic.

You can map audio tracks, as well as video, to the secondary display.

PRO
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Virtual Camera Out

Enables you to present the output of Wirecast as if it were a camera (a virtual camera), 
allowing it to be automatically detected by other applications when they are launched. 
Outputs only the Live Program feed. 

For more detailed information, see Virtual Camera.

Active Broadcast

Once you have logged into your YouTube or Twitch account and you start streaming, 
you can select Active Broadcast to display the YouTube broadcast window in a browser.

Control Room (YouTube only)

Once you have logged into your YouTube account, you can select Control Room to 
display the YouTube control room window in a browser.

Dashboard (Twitch Only) Once you have logged into your Twitch account, you can 
select Dashboard to display the Twitch dashboard window in a browser.

VOD of Last Broadcast Enables you to view the most recent completed broadcast.

Note: Active Broadcast is enabled only for Twitter-Live Broadcast and YouTube., 
Control Room and VOD of Last Broadcast are enabled only when you are logged into 
YouTube.

Facebook (Facebook Live Only)

Select Active Broadcast to display your Facebook Live event.

Twitter

Opens menu to monitor your Twitter broadcast.

• Active Broadcast Once you have logged into your Twitter account and you start 
streaming, you can select Active Broadcast to display the your broadcast window in 
a browser.

• Producer Dashboard Once you have logged into your Twitter account, you can 
select Producer Dashboard to display the Twitter dashboard window in a browser. In 
the dashboard you can start your broadcast by clicking the Go Live button. 

To stop your broadcast click the Stop Stream button.

• Toggle Broadcast Click to toggle between Go Live and Stop Broadcast on the 
Producer Dashboard.

Canvas Size

Sets the canvas size resolution used when broadcasting a Wirecast document.

Note: You should match the output to the canvas size as close as possible to preserve 
video resolution and quality. For example, a 800x600 source results in significant loss 
of quality if a resolution of 640x480 is selected. Using 720x576, which is much closer in 
size, helps preserve video quality.
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Show Statistics

Displays the statistics window for your broadcast. You can select (for display): Bitrate, 
RTMP Queue Size, Framerate, System CPU Usage, and System Memory Usage.

 

NDI Output

Sends the output of the Live Program feed. Select the output resolution for your NDI 
output. You can also select a link that will take you to NDI.NewTek.com for additional 
information.

Note: Although SDI supports 16 discrete audio channels, Wirecast Pro video out 
currently only supports two channels.

Blackmagic Cards

Note: If you are updating to Wirecast 14 (or a previous version) and have multiple 
capture cards that are different models, when you open a saved document that 
contains sources from the capture cards, one of the inputs may fail to upgrade (and 
will show their saved source.) To remedy this re-add the missing source back into the 
document, then open the Asset Manager and assign that newly added source to back 
into its saved shot.

You can use Blackmagic cards to send live feeds directly into editing, effects and 
broadcast design systems. In order to use this feature, install a Blackmagic card with 
associated drivers, then restart Wirecast. The Blackmagic card with then be listed in the 
Output menu.

Under the Output menu, select a Blackmagic card, and then select an HD setting for its 
output. If your card has multiple outputs, you can select more than one and all will 
output simultaneously at independent resolutions and Frame rates.

To begin outputting, select Start Output and chose a setting.

You can stop the Blackmagic card output by selecting Stop Output. If you have multiple 
outputs selected, they will all stop outputting.

Note: Some Blackmagic cards do allow input and output simultaneously, but need to 
be configured in the Blackmagic software.

PRO
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Layout Menu
To optimize the user interface for each document, you can configure the Wirecast 
layout.

Wirecast enables you to select which functions are displayed in the default layout. 
These functions are added or removed from the default layout using the Layout menu.

Final Mix

When checked, displays the Final Mix Audio controls. Final Mix Audio controls are 
located on the left and right sides of the default layout.

Show Live and Preview

When checked, displays the Live and Preview windows, and allows you to select 
between displaying the Preview Area only, the Live Broadcast Area only, or both.

Show Preview Only

Displays the Preview Area only.

Show Live Only

Displays the Live Broadcast Area only.

Note: The three controls above work  the same as the Mode Control buttons at the 
top-right of the default layout. See Mode Selection Buttons.

Zoom Layers In

Increases the size of all the layer icons.

Zoom Layers Out

Decreases the size of all the layer icons.

Zoom Layers To

Sets the size of all the layer icons to: 50%,100%, or 200%. 

Note: You can also change each layer size by clicking and dragging the divider line 
between layers. Additionally, you can change the size of all layers by holding the Ctrl 
key while clicking and dragging the divider line between layers.

Go to Layer

Displays the selected layer. You can also press Ctrl + Shift keys with the T, F, N, B, or A 
keys to select a layer. Each of these letter keys represents a layer name: Title, 
Foreground, Normal, Background, and Audio.
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Replay + ISO Menu

 

Start All

Activates the Create Replay Shot system. When activated, the menu item becomes 
Deactivate. Click Deactivate to deactivate the Create Replay Shot system.

Activate

Activates the Create Replay Shot system. When activated, the menu item becomes 
Deactivate. Click Deactivate to deactivate the Create Replay Shot system.

Configure ISO Outputs 

Once ISO outputs are created, all ISO outputs are listed in this menu. To configure an 
ISO output, click Configure, then click the Add ISO button.

Note: You can create ISO recordings of any source or shot in your document.

Replay Mark All

Allows you to tighten up your Replay Shot capture. Select Replay Mark In to mark the 
beginning point of your Replay Shot capture.

Create All Replay Shots

Select Create to create additional Replay shots. 

Update All Replay Shots

If no replay shot exists, selecting Update creates a new Replay shot. There after, 
selecting Update updates the first Replay shot created.

Configure

Displays the Replay Shot settings window.

For more information about Replay Shots see Replay + ISO Menu. 

ISO enables you can set up ISO recording and do Replays from the same menu. To use 
Replay and ISO functionality, select the Replay + ISO menu.

Start All

Activates all configured ISO shots and/or the Program Replay.   When activated, the 
menu item becomes Stop All. Click Stop All to deactivate the Create Replay Shot system.

Program Replay

Allows you to Stop, Mark In, Create, or Update a relay shot.

 

Replay Mark All

Allows you to tighten up your Replay Shot capture. Select Replay Mark In to mark the 
beginning point of your Replay Shot capture.

PRO

PRO
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Create All Replay Shots

Select Create to create additional Replay shots. 

 

Update All Replay Shots

If no replay shot exists, selecting Update creates a new Replay shot. There after, 
selecting Update updates the first Replay shot created.

 

Configure

Displays the Replay Shot settings window.

Once ISO outputs are created, all ISO outputs are listed in this menu. To configure an 
ISO output, click Configure, then click the Add ISO button.

See Configuring Replay + ISO.

Social Menu
Two social media options are provided: Facebook and Twitter. Facebook enables you to 
receive polling data from viewers. Twitter enables you to add Twitter messages to your 
broadcast along with filtering the messages displayed.

Facebook
The Social > Facebook menu contains the Create New Poll option as well as a list of any 
previously-created polls.

See Creating a Facebook Poll and Selecting a Facebook Poll.

Twitter
Message Feed Brings up your Twitter feed.

Create Shot Creates a shot with a social media title in Main Layer 1.

Settings Brings up the Social Media Settings dialog.

Authenticate

Click to authenticate your account with Twitter. Enter your pin when the PIN field 
displays.

Feed Type

Select a Feed Type: Home Timeline, User Timeline, Favorites, Search. If you select 
Search, the Search String field becomes active.

PRO

PRO

PRO
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Search String

Enter a search string. (Active only when Search is selected in Feed Type above.)

(See  in the Social Media section of this user guide for more detailed information).

Comments
Opens a dialog listing comments about the broadcast that are posted to Facebook, 
Twitter, or YouTube.

Window Menu
Welcome to Wirecast

Displays the Welcome screen.

Encoder Presets

Opens the Encoder Presets window.

See Encoder Presets and The Encoder Presets Window.

Audio Mixer

Opens the Audio Mixer window.

See The Audio Mixer Window.

PTZ Controller

 

Opens the PTZ Controller Panel.

Wirecast Pro allows you to remotely control cameras with built-in pan, tilt and zoom 
(PTZ) features using the built-in PTZ Controller window. This feature currently works 
with PTZOptics and Lumens cameras that support VISCA over IP control, as well as NDI 
PTZ protocol controls.

See The PTZ Controller Panel.

Show USB Devices

Opens a list of all USB devices.

Open Rendezvous Dashboard

Opens a Rendezvous Dashboard. Click Start Session to use. 

See Rendezvous.

 

Open Advanced Rendezvous Audio Mixer

PRO

PRO
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Displays the Rendezvous Audio Mixer window.

– Output from document Select document source via the pull-down menu.

– Channel Output level indicators for each channel.

– Include In Mix When checked, this audio source is included in your Rendezvous 
session.

– Audio Level (Sliders) Move the sliders Library to adjust the audio level.

Download Manager

Opens the Stock Media download monitor window. Whenever you add a Stock Media 
Library file, the downloading progress is displayed. You can cancel a download by 
clicking on the X icon. To navigate to the location of a downloaded file, click the 
spyglass icon.

Notifications

Opens the notifications window. This window displays last “important” log messages 
and other application health messages.

New Layer Window

Opens a new Main Layer window for the layer selected.

Document Windows

All open document windows are listed at the bottom of this menu.

Help Menu
Wirecast Help

Opens the online version of the User Guide.

Open Wirecast PDF User Guide

Opens the PDF version of the User Guide.

Open Tutorial HTML

Opens the Wirecast Tutorial in your browser. To follow the tutorial, you'll need to Create 
a Document for the Tutorial as well.

Create Document for Tutorial

Creates a new Wirecast Document which contains the media necessary for following 
the Tutorial.

Buy/Upgrade

Opens Licenses in the Preferences window. This window allows you to purchase licenses 
and to activate or deactivate them.

Provide Feedback

Opens the Telestream Website feedback page where you can enter any feedback you 
may have about our product or company.
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Send Support Information

Opens a Support Assistant dialog window. To create a new support ticket, select Create 
a support ticket. The information is sent to the Telestream support team for evaluation. 
If you have been previously issued a case number, select Link with existing support case 
# and enter your case number. You can also select Do not receive follow-up from 
Telestream. This enables you to send support information to Telestream without 
receiving a response. Click Save Report to save the information to a file on your 
computer. Click Send Report to send the information to Telestream.

For troubleshooting purposes, you can reset your preferences to the defaults by 
clicking the Reset Preferences button. This will reset your preferences and create a 
backup of your current preferences, in case TS Support needs it.

For troubleshooting without resetting preferences, you can also open Wirecast in “Safe” 
mode using Shift + Control + Open.

Note: You must click Send Report to create a ticket. If you click Save Report, a ticket will 
not be created.

Open Scripting Documentation Opens the Wirecast Scripting Help document.

Show Scripting Examples Opens the directory where the Wirecast Scripting examples 
are located.

Visit Telestream LLC Website

Opens the Telestream Website home page.

Visit Wirecast / Desktop Presenter download page

Opens the Telestream Website download page for Desktop Presenter.

Acknowledgments

Opens an on-line help to Acknowledgments.

About Wirecast

Displays version and copyright information about Wirecast.
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